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Read Me First
Read Me First
Read this section before continuing with the rest of the guide.

Warnings

In all NDI documentation, warnings are marked by this symbol. Follow 
the information in the accompanying paragraph to avoid personal 
injury.

For a complete list of warnings, refer to the documentation that 
accompanied your system. 

Cautions

Caution! In all NDI documentation, cautions are marked with the word 
"Caution!" Follow the information in the accompanying paragraph to 
avoid damage to equipment.

For a complete list of cautions, refer to the documentation that 
accompanied your system.

Contact Information
If you have any questions regarding the content of this guide or the 
operation of this product, please contact us:

Warning!

Email: APsupport@ndigital.com
Website: www.ndigital.com

Unit 301, 3/F Core Building 1
No. 1 Science Park East Avenue,
Hong Kong Science Park,
Shatin, New Territories,
Hong Kong

Phone: + (852) 2802 2205
Fax: + (852) 2802 0060

Fritz-Reichle-Ring 2
D-78315 Radolfzell
Germany

Phone: + 49 (77 32) 939 19 00
Global: + (800) 634 634 00
Fax: + 49 (77 32) 939 19 09

Email: support@ndieurope.com
Website: www.ndieurope.com

103 Randall Drive
Waterloo, ON, Canada N2V 1C5

Phone: + 1 (519) 884-5142
Toll Free: + 1 (877) 634-6340
Global: + (800) 634-634-00
Fax: + 1 (519) 884-5184

Email: support@ndigital.com
Website: www.ndigital.com
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Read Me First
Updates
NDI is committed to continuous improvements in the quality and 
versatility of its software and hardware. To obtain the best results with 
your NDI system, check the NDI Support Site regularly for update 
information:

http://support.ndigital.com
First Principles User Guide - Revision 3 v
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About This Guide

Introduction

This guide is intended for users of the Optotrak®  or Optotrak Certus® 
measurement system who wish to use First PrinciplesTM software to 
collect and manipulate the data produced by experiments.

Assumptions

It is assumed that you are familiar with the Microsoft® Windows® 
environment. It is also assumed that you are familiar with the Optotrak 
System, in particular:

• you know what markers, rigid bodies, and tools are

• you know what strobers are

• you know the difference between global and local coordinate 
systems

• you understand what a tool definition file is

• if you are using an ODAU II, you understand how it works

Related Documentation
Refer to the documentation that was delivered with your system for 
detailed information on the use of the Optotrak System.



1 What is First Principles?
First Principles is an application software package that provides you with 
an easy way to observe, record, play back and manipulate the data 
produced by an experiment. 

Note An experiment is a specific Optotrak System setup that uses markers, 
rigid bodies, tools, and/or ODAU II units to measure the movement and/or 
location of a subject/object. 

Record and play back data  Use First Principles to observe and record the 
data that your experiment produces. The software includes a simple 
interface to enable you to play back recorded data. You can save and 
export a collection at any time during (or after) an experiment. In 
addition, you can open previously collected data to review and analyze. 

Manipulate data  First Principles provides you with the power to 
manipulate data at any time. You can change the physical setup of the 
experiment and observe the effects of these changes on the experiment 
without having to re-initialize the Optotrak System or stop tracking. You 
can also apply calculations to the collected data in real time or when 
playing back the data. 

Manage the system  First Principles provides you with the ability to test 
specific elements of an experiment, before performing the experiment 
itself. For example, you can check that markers are being measured 
properly, that the current registration is accurate, and that the software is 
communicating with the Optotrak System correctly. 

1.1 Working with Experiments
A First Principles experiment may comprise a number of sessions, which 
in turn may comprise a number of collections. For example, consider an 
experiment named “Gait Analysis”. On day one, you take a number of 
“collections” from subject A and save those collections as “Session 1”. 
On day two, you open the “Gait Analysis” experiment and take a number 
of “collections” from subject B and save those collections as “Session 2”. 

The following paragraphs provide an overview of the process for working 
with experiments. With First Principles you can create a new experiment, 
or open an existing one. Figure 1-1 shows a flowchart of the process. 
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Figure 1-1  Experiment Process Overview

1.   Start

a) Connect and power on the Optotrak hardware components. 

b) Open First Principles.

2.   Create/Open an Experiment 

Choose either to create a new experiment, or to open and continue 
work on an existing experiment. 

Note The experiment file extension is .exp.

Start

Environment Setup

Experiment Setup

Session Setup

Work with Collected Data

Close/Save Experiment

Finish

Create a new experiment/
Open an existing experiment
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3.   Environment Setup

a) If you have multiple Position Sensors connected to your system, 
you must perform a registration, if it was not done recently. 

b) If you want to move the  global coordinate system to a new 
location, you can perform an alignment. 

First Principles provides an easy-to-use wizard to perform both these 
steps. 

4.   Experiment Setup 

If you are working with an existing experiment, you can either make 
changes to the experiment setup already created for it, or you can skip 
over this step and proceed directly to step 5.

a) Connect the hardware components of the experiment — 
strobers, markers, rigid bodies, and/or tools. 

b) In the Experiment Setup window, describe the components 
being used, so that your system can track them properly. 

5.   Session Setup 

a) Choose a file location for saving collections. 

b) If you chose to create temporary imaginary markers, digitize 
these points using the simple procedure provided with First 
Principles. 

6.   Work with Data

• View the data produced by the experiment in real time. 

• Perform collections of produced data. If you choose to do so, 
data is automatically exported to predefined file formats. 

• Manipulate your experiment both by changing your setup or by 
adding calculations to the data produced. 

• Save and/or export data collections for future analysis.

7.   Save Experiment

Save the experiment setup for future sessions.
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8.   Finish

1.2 Working with Collected Data
To open and work with previously collected data, First Principles 
provides the following process:

Figure 1-2  Reviewing Data Overview

1.   Start

Open First Principles.

2.   Open Data Collections

Browse to and select data collections made in a previous experiment.

Note The data collection file extension is .nco.

3.   Work with Data

a) Use the view settings to customize the main window to display 
your selected data collections in a manner useful to your 
particular analysis.

b) Review the data collections using playback functionality.

c) Manipulate the data collections by adding or removing 
calculations. 

Start

Work with Data

Finish

Open Collection
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d) Export data collections for future analysis.

e) Save new view settings and calculations by saving the 
collection.

4.   Finish

1.3 Installing First Principles 

System Requirements
To run First Principles, you must have the following:

❒ Windows XP/Vista/7 (32 or 64 Bit)

❒ Internet Explorer 5.0 or above

❒ video card with Open GL support

❒ monitor that supports a resolution of 1024 x 768

❒ Pentium 4 Processor or better

❒ 256 MB RAM

To run First Principles, NDI also recommends having the following:

❒ 2 GB RAM or more

❒ 300 GB or more free hard drive space

❒ monitor that supports a resolution of 1600 x 1200

❒ wheel mouse

❒ 17-inch monitor or larger

Installation Procedure
1. Close all other programs before installing First Principles; once the 

installation is complete, you will be prompted to restart your 
computer. 

2. Insert the First Principles CD into the computer’s CD drive.

3. Follow the steps as directed by the automatic installation wizard. 
First Principles User Guide - Revision 3 5



By default, this wizard stores all program files on C:\Program 
Files\Northern Digital Inc\NDI First Principles. You must be able 
to read and write to this location.

Some NDI data files used and created by First Principles are stored 
in the ‘ndigital’ directory. This directory is defined by the ND_DIR 
environment variable, and can typically be found in C:\ndigital. You 
must be able to read and write to this location.

Note NDI recommends that this directory not be changed during installation. 

4. If prompted, restart the computer. 

5. Start First Principles. The licence update dialog will appear. Refer to 
the following section for details on licences. 

About Licences
First Principles is distributed free for a trial period of 120 days from the 
day you install it. During the trial period, all product features are 
available. You may purchase the full version or activate a free version at 
any time during the trial period. The free version provides only playback 
functionality. 

When you start First Principles for the first time, the licence update 
dialog appears:
6 First Principles User Guide - Revision 3



Figure 1-3  Licence Update

This dialog displays the number of days left in your free trial and presents 
three options as follows:

1. Continue with Trial. This option provides access to all features, 
providing the trial period has not expired. Once the trial period 
expires, this option is not available. 

2. Purchase/Activate NDI First Principles. This option guides you 
through the purchase and activation procedure. 

3. Activate free version (Playback Only).This option activates the 
free, playback only, version. (If you activate the free version, you 
still have the option to purchase the full version at any time.)

Note You may select Continue with Trial at any time from any licence dialog. 

Select the desired option and click Next. If you select Continue with 
trial or Activate free version, the dialog will close and First Principles 
will start. If you select Purchase/Activate NDI First Principles, the 
activate dialog appears:
First Principles User Guide - Revision 3 7



Figure 1-4  Activate Dialog

This dialog displays NDI contact information and two activation options, 
online and manual. Select the desired option and click Next. Proceed to 
online activation or manual activation as appropriate. 

Note NDI contact information is also listed under “Contact Information” on 
page iv. You will need to contact NDI to purchase First Principles and to 
obtain the necessary activation information. 

Online Activation 

If you select Online Activation, the following dialog appears:
8 First Principles User Guide - Revision 3



Figure 1-5  Online Activation

1. Make sure that your computer is connected to the internet. Enter the 
Licence ID and Password as supplied by NDI. 

2. Click Finish. If activation is successful, the dialog closes and First 
Principles starts. 

Manual Activation

If you select Manual Activation, the following dialog appears:
First Principles User Guide - Revision 3 9



Figure 1-6  Manual Activation

1. Contact NDI and provide user code 1 and user code 2. NDI will 
supply you with registration code 1 and registration code 2.

2. Enter the information supplied by NDI in the appropriate fields. 
Click Finish. If activation is successful, the dialog closes and First 
Principles starts. 

Licence Management

Licence status information and update options are also accessible when 
First Principles is running. To view the current licence status, select Help 
> Licencing Info. The following dialog appears:
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Figure 1-7  Licence Status

The Licence status box displays the current status. To Activate 
additional features, select the associated checkbox and click Next. The 
Activate dialog appears as previously described, refer to “Activate 
Dialog” on page 8. 
First Principles User Guide - Revision 3 11
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2 Getting Started
To start using First Principles, complete the following tasks:

1. Set up hardware and start software

2. Adjust communication settings

Note If you are only going to open and review existing data collections, you do 
not need to be connected to an Optotrak System or be concerned with 
communication settings. 

2.1 Set Up Hardware and Start Software
1. Refer to the system documentation and place and connect the main 

hardware components of your Optotrak System:

❒ SCU

❒ Position Sensor(s)

❒ link cables

❒ power cables

❒ communication cables to host computer

2. Power on the system. 

3. Start First Principles. 

When you start First Principles, the software automatically attempts to 
connect to the Optotrak System, establish communication, and determine 
what hardware components are being used in your setup. 

2.2 Adjust Communication Settings
Check the communication settings to ensure that they are correctly 
assigned. From the main menu, select Settings > Communication 
Settings. The Communication Settings Dialog appears:
First Principles User Guide - Revision 3 13



Figure 2-1  Communication Settings Dialog

If you are you using a PCI card:
1. From the Connection Type drop-down list, select PCI.

2. Click OK (no other input required).

If you are using a SCSI card:
1. From the Connection Type drop-down list, select SCSI. The SCSI 

Settings Dialog  appears:

Figure 2-2  SCSI Settings Dialog

2. Enter the Host ID. You can determine the Host ID using the program 
NDI SCSI Check. This program is available from NDI Technical 
Support. 
14 First Principles User Guide - Revision 3



3. Enter the Target ID found on the back of the SCSI box. SCSI IDs 
are numbered from 0 though 7, and are used by the workstation to 
distinguish between the devices connected to the SCSI bus. 

4. Enter the Time Out. Set this value to the time that the system will 
wait for communication until it times out. A recommended default 
value is 10 (seconds).

If you are using an Ethernet connection:

Note For detailed information about using Ethernet to communicate with an 
Optotrak System, refer to the documentation delivered with your system. 

1. From the Connection Type drop-down list, select Ethernet. The 
Ethernet Settings Dialog appears:

Figure 2-3  Ethernet Settings Dialog

2. If you are using a static IP address, set the IP Address to that of the 
SCU. If you are using DHCP, set the Hostname instead of IP 
Address. (The Hostname is SCU's serial number string without a 
dash "-".)

Note Depending on your facility setup, a network using DHCP may 
automatically assign an IP address to the SCU. Please consult your 
network administrator for information specific to your facility setup. 

3. Click OK.
First Principles User Guide - Revision 3 15



2.3 Query System
If you decide to change your hardware setup after starting First 
Principles, use the Query System utility to ensure that the software is 
aware of your changes. This function is also useful to check that the 
software is communicating correctly with the system and that all devices 
are correctly connected.

After making your changes, select Utilities > Query System. The 
software re-initializes the connected Optotrak System and attempts to 
determine its new hardware configuration. The Sample Query System 
Results Dialog appears:

Figure 2-4  Sample Query System Results Dialog
16 First Principles User Guide - Revision 3



3 Environment Setup
Before performing an experiment, you must set up the global coordinate 
system in which the experiment will be tracked. This process can be as 
simple as deciding to use the default global coordinate system of a single 
Position Sensor. Alternatively, this process can be as complicated as 
using several Position Sensors to track a marker using a common global 
coordinate system that, in addition, has been moved to a customized 
location. 

First Principles provides you with an easy-to-use wizard that walks you 
through an environment setup and automatically saves your choices for 
future sessions. 

3.1 Understanding the Environment Setup Wizard
The environment setup wizard allows you to review the current global 
coordinate system setup before using the system. Environment setup 
involves two possible processes; registration and alignment. 

What is Registration?
If the software detects two or more Position Sensors connected to the 
system, you must perform a registration procedure. Registration is the 
process of aligning all the Position Sensors’ coordinate systems to that of 
one of the Position Sensors, producing a single global coordinate system 
against which the position and orientation of rigid bodies, tools, and 
markers are measured. 

For more information about registration, refer to the system user guide.

What is Alignment?
Alignment is the process of changing the default global coordinate system 
(placed at a Position Sensor) to the location of either a rigid body’s 
coordinate system, or that produced by a combination of digitized points. 

For more information about alignment, refer to the system user guide.
First Principles User Guide - Revision 3 17



Note If you choose to perform both a registration and an alignment, remember 
that registration always comes first and that it invalidates any previous 
alignment.  

What is the Environment Setup Process?
The Environment Setup wizard walks you through both registration and 
alignment using the following process:

Figure 3-1  Environment Setup Process

3.2 Accessing the Environment Setup Wizard
There are two ways to access the Environment Setup wizard:

1. Select Settings > Coordinate System Details or,

2. Create either a new experiment or open an existing experiment:
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• Select File > New Experiment to create an entirely new 
experiment.

• Select File > Open Experiment to browse to and open an 
existing experiment (.exp).

Figure 3-2  Environment Setup Window

3.3 Choosing to Perform a Registration
If the system has detected two or more Position Sensors connected to the 
system, the Environment Setup window enables the Position Sensor 
Registration dialog:  
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Figure 3-3  Position Sensor Registration Dialog

The Position Sensor Registration dialog provides the following 
information and options:

• It confirms that you have multiple Position Sensors connected to 
your system. 

• It displays the details of the last time the detected Position 
Sensors were registered and their serial numbers. 

• It offers you the option of reusing the current registration. For 
example, select this option if you are performing an experiment 
in which you are certain that the Position Sensors have not been 
moved since the last registration. You will not need to re-
register.

Note NDI recommends that you perform a registration daily and each time you 
move the Position Sensor(s), or change the physical setup of the Position 
Sensor(s).

Using the information provided in this section, choose one of the 
following actions:

• Choose Use Current Registration if you do not wish to make 
any change from the last settings. If you select this option, the 
previous registration information will be applied to the global 
coordinate system, and you are moved on to Experiment Setup. 
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• Choose Perform New Registration if you wish to perform a 
new registration. See “Performing a Registration” on page 23.

3.4 Choosing to Perform an Alignment
The Global Coordinate System Alignment dialog offers you the 
opportunity to perform an alignment before collecting any experiment 
data: 

Note Make sure you perform an alignment before you collect data. Unlike 
previous versions of NDI software, you will not be able to re-align the 
coordinate system once data has been collected. 

Figure 3-4  Global Coordinate System Alignment Dialog

The Global Coordinate System Alignment dialog provides the following 
information and options:

• It shows you the details of the last time an alignment was 
performed. 

• It offers you the option of reusing the current alignment. 

• It offers you the option of resetting the alignment to the default 
global coordinate system (the Position Sensor). 

Using the information provided in the dialog, choose one of the following 
actions:
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• Choose Use Current Alignment  if you do not wish to make 
any changes from the last settings. If you choose this option, the 
previous alignment information will be applied to the global 
coordinate system, and you are moved on to the next step.

• Choose Use Default Alignment if you want to change the 
alignment to the global coordinate system, with its origin in the 
Position Sensor. 

• Choose Perform New Alignment to perform a new alignment 
procedure. See “Performing an Alignment” on page 31.

3.5 What Next?
Performing a new registration? Go to “Performing a Registration” on 
page 23.

Performing a new alignment? Go to “Performing an Alignment” on 
page 31.

Using existing alignment/registration information (either customized or 
default)? Go to either “Experiment Setup for an Optotrak 3020” on 
page 41, or “Experiment Setup for an Optotrak Certus” on page 53.
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4 Performing a Registration
Registration is the process of aligning multiple Positions Sensors’ 
coordinate systems to that of one Position Sensor, producing a single 
global coordinate system against which rigid bodies, tools, and markers 
can be measured. 

The registration process consists of the following:

1. Multiple Position Sensors track markers on the same rigid body or 
tool (known as a registration object) throughout a shared 
measurement volume area. “Shared” can mean any of the following:

• Multiple measurement volumes overlapping a common area. 

• If two measurement volumes do not overlap a common area, 
they must both overlap in areas with a third measurement 
volume. 

• For a string of Position Sensors, a common link must exist 
between their measurement volumes in order to be considered 
sharing. For example, for an environment setup involved four 
Position Sensors, measurement volume 1 must overlap 
measurement volume 2, which must overlap measurement 
volume 3, which must overlap measurement volume 4. In this 
manner, measurement volume 4 is sharing with measurement 
volume 1.

2. Using the tracking information returned from each Position Sensor, 
the software calculates the location of each Position Sensor’s 
coordinate system with respect to each other. 

3. The software calculates and applies the transformations required to 
shift all coordinate systems to that of only one of the Position 
Sensors thus creating one global coordinate system. (The Position 
Sensor will be the furthest one physically connected to the SCU) 

Note For more information about registration and rigid bodies/tools, refer to 
the system documentation.
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4.1 Registration Procedure
The Environment Setup wizard provides you with the following 
registration procedure:

Figure 4-1  First Principles Registration Procedure

Once you have chosen to perform a new registration, the Environment 
Setup wizard begins. Refer to “Registration Welcome Window” on 
page 25:
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Figure 4-2  Registration Welcome Window

1. Following the on-screen instructions, connect the registration rigid 
body or tool to the SCU. (If you are using an Optotrak 3020 system, 
connect the rigid body or tool to Port 1 on the SCU.) Make sure that 
there are no other tools, rigid bodies, or markers plugged into the 
system. 

2. Click Next. The following window appears: 
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Figure 4-3  Registration Procedure — Select a Tool Definition File

3. Choose from the options provided:

• If you are using a registration rigid body, choose Select the tool 
definition file from a directory and browse to the desired tool 
definition file (.rig). 

• If you are using a registration tool with a programmed SROM 
device, select Use the tool definition file programmed in the 
tool’s SROM device. This option is not available for Optotrak 
3020 systems, as they do not support SROM devices.

Note If you wish to use a tool definition file other than that programmed in the 
SROM device of a connected tool, select the tool definition file from a 
directory.
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4. Click Next. The following window appears: 

Figure 4-4  Registration Procedure — Collect Registration Data

5. Pre-registration check. The Position Sensors are numbered and 
listed by serial number at the right side of the display. They are also 
represented graphically by their number. Slowly move the 
registration object throughout the combined volume and notice that, 
as each Position Sensor sees at least three markers of the object, a 
green background appears behind the Position Sensor number. Using 
this method you can determine the limits of the combined volume 
that you will cover during the actual registration procedure. 

6. Enter a Collection Time in seconds. Enter a time that will allow you 
to cover the combined volume during the registration process. 
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7. (Optional) Enter a Collection Delay, in seconds. Enter a time that 
will allow you time to position the registration object before the 
collection begins.  

8. Click Register and begin to slowly move the registration object 
throughout the combined volumes, as determined in step 5. As the 
overlapping volumes of two Position Sensors are registered, a “blue 
sphere” icon appears between the two applicable Position Sensors. If 
two Position Sensors are registered because they share a common 
volume with a third Position Sensor, a small “blue sphere” icon 
appears.

Move the registration object throughout the combined volume, 
making sure that all combinations of overlap contain either large or 
small “blue sphere” icons.  

9. At the end of the collection, a Registration Results section appears at 
the bottom of the window, displaying either “Registration 
Successful” or “Registration Failed”. 

• If your registration failed, click Register to try again. Also see 
“Registration Hints” on page 29.

• If your registration is successful and you are satisfied with the 
resulting RMS Error, click Finish. If you wish to review the 
result details, click View Log.  

An example of a successful registration is shown in “Successful 
Registration” on page 29.
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Figure 4-5  Successful Registration

What Next?
Performing an Alignment? Continue on with “Performing an Alignment” 
on page 31. 

Not performing an Alignment? The Environment Wizard closes and the 
Experiment Setup window appears. Go to either “Experiment Setup for 
an Optotrak 3020” on page 41, or “Experiment Setup for an Optotrak 
Certus” on page 53. 

4.2 Registration Hints
• Be sure that each Position Sensor has some overlapping 

measurement volume with at least one other Position Sensor in 
the setup. 
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• Be sure that the markers on the registration object are plugged 
into the SCU, can be seen by the Position Sensors, and are in the 
shared measurement volume area.

• Be sure that you selected the proper tool definition file for the 
registration object.

• When moving the registration object throughout the shared 
measurement volumes, be sure that a) you are moving it 
SLOWLY, and b) you have moved it at least 500 mm in each 
direction (up, down, and sideways).
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5 Performing an Alignment
Alignment is the process of transforming the global coordinate system to 
a new location that is more meaningful to your experiment.

There are two ways to perform an alignment:

• Align to digitized points: Collect snapshots of specific points in 
the measurement volume using a digitizing probe. Use the 
location of these points to calculate a new global coordinate 
system. 

• Align to a rigid body or tool’s coordinate system: Perform a 
collection of a static rigid body/tool (also known as an alignment 
object). Use the resulting transformations to calculate the 
alignment object’s local coordinate system, and then transform 
the global coordinate system to this location. 

Note For more information about alignment objects, refer to the system user 
guide.

5.1 Alignment Procedure
The Environment Setup wizard provides you with the following 
alignment procedure:
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Figure 5-1  First Principles Alignment Procedure

Once you have chosen to perform a new alignment, the Alignment wizard 
begins, as shown in “Alignment — Welcome Window” on page 33:
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Figure 5-2  Alignment — Welcome Window

1. Connect either the alignment object or the digitizing probe to the 
SCU. (If you are using an Optotrak 3020 system, connect the 
alignment object of digitizing probe to Strober Port 1 on the SCU.) 
As instructed, make sure that there are no other tools, rigid bodies, or 
markers plugged into the system. 

2. Click Next. The following window appears:
First Principles User Guide - Revision 3 33



Figure 5-3  Alignment — Select an Alignment Method

3. Select how you wish to perform the alignment: 

• Align to digitized points: Collect snapshots of specific points in 
the measurement volume using a digitizing probe. 

• Align to a rigid body or tool’s coordinate system: Perform a 
static collection of an alignment object. 

4. Click Next.

• If you chose to use digitized points, go to “Using Digitized 
Points” on page 35.

• If you chose to use an alignment rigid body/tool, go to “Using 
an Alignment Object” on page 37. 
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5.2 Using Digitized Points
If you have chosen to perform an alignment using digitizing points, the 
following appears:

Figure 5-4  Alignment — Select a Tool Definition File

1. Choose from the options provided:

• If you are using a digitizing rigid body, choose Select the tool 
definition file from a directory and browse to the desired tool 
definition file. 

• If you are using a digitizing tool with a programmed SROM 
device, select Use the tool definition file programmed in the 
tool’s SROM device. This option is not available for Optotrak 
3020 systems, as they do not support SROM devices.
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Note If you wish to use a tool definition file other than that programmed to a 
connected probe, select the tool definition file from a directory.

2. Click Next. The following window appears:

Figure 5-5  Alignment — Align to Digitized Points

3. Step 1: Digitize the Origin: 

a) Place the digitizing probe’s tip at the new origin of the desired 
global coordinate system. 

b) Click Digitize or press F5. The software collects a single frame 
of data to determine the location of that point. This location will 
serve as the new origin of the global coordinate system.
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4. Step 2: Digitize an Axis:

a) Select an axis from the drop-down list provided.

b) Place the digitizing probe’s tip on this new axis of the global 
coordinate system.  

c) Click Digitize or press F5. The software collects a single frame 
of data to determine the location of that point. The software uses 
this location to determine the selected axis of the new global 
coordinate system.

5. Step 3: Digitize a Plane:

a) Select a plane from the drop-down list provided. Notice that the 
options provided are automatically limited to planes that extend 
from the selected axis determined in the previous step.

b) Place the digitizing probe’s tip on this new plane of the global 
coordinate system.  

c) Click Digitize or press F5. The software collects a single frame 
of data to determine the location of that point. The software uses 
this location to determine the plane of the new global coordinate 
system.

6. Once you have completed the three steps in the Alignment dialog, 
the software calculates a new global coordinate system based on the 
location of the digitized origin, axis and plane. Click Finish.   

What Next?
Go to either “Experiment Setup for an Optotrak 3020” on page 41, or 
“Experiment Setup for an Optotrak Certus” on page 53.

5.3 Using an Alignment Object
If you have chosen to perform an alignment using an alignment object, 
the following windows appears:
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Figure 5-6  Alignment  — Select a Tool Definition File

1. Choose from the options provided:

• If you are using an alignment rigid body, choose Select the tool 
definition file from a directory and browse to the desired tool 
definition file. 

• If you are using an alignment tool, select Use the tool definition 
file programmed in the tool’s SROM device. Note that this 
option is not available for Optotrak 3020 systems, as they do not 
support SROM devices.

Note If you wish to use a tool definition file other than that programmed to an 
alignment tool, select the tool definition file from a directory.
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2. Click Next. The following window appears:

Figure 5-7  Alignment — Collect Alignment Object Data

3. Using both the real-time Marker Positions table and spatial view 
provided for guidance, place the alignment object in the 
measurement volume so that the rigid body/tool’s transformation can 
be seen.

4. Move the alignment object to the location of the new global 
coordinate system, so that its own origin matches the origin of the 
desired new global coordinate system. 

5. Rotate the alignment object until its own coordinate system is in the 
orientation of the desired new global coordinate system. 

6. Click Collect. 
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Note Do not move the alignment object during the collection, or the alignment 
will fail. 

7. At the end of the collection, an alignment results section appears at 
the bottom of the window, displaying either “Alignment Successful” 
or “Alignment Failed”. 

• If your alignment failed, click Collect to try again. Also see 
“Alignment Hints” on page 40 to learn more about possible 
reasons why it was not successful.

• If your alignment is successful and you are satisfied with the 
resulting RMS Error, click Finish.  

What Next?
Go to either “Experiment Setup for an Optotrak 3020” on page 41, or 
“Experiment Setup for an Optotrak Certus” on page 53.

5.4 Alignment Hints
Be sure the alignment object's markers are plugged in, and in view of the 
Position Sensor(s) and in the measurement volume. 

Be sure you select the correct tool definition file.

Be sure the alignment object is completely stationary when the system is 
collecting the alignment data file.
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6 Experiment Setup for an Optotrak 3020
This section details the procedure required to set up an experiment using 
an Optotrak 3020 System. (For details on setting up an experiment using 
an Optotrak Certus System, refer to “Experiment Setup for an Optotrak 
Certus” on page 53.)

Figure 6-1  Experiment Setup Initial Window

1. As directed by the initial window, set up your experiment by 
plugging in all markers, rigid bodies, and/or ODAU IIs required for 
your experiment.

2. Click Next when you are ready. The Experiment Setup window 
appears. This window provides three tabs that allow you to set up:

• markers

• rigid bodies
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• ODAU IIs

Note If you have opened a previously created experiment, its setup information 
will be loaded and the software will provide you with a list of expected 
rigid bodies and/or markers. Check against this list before clicking Next.  

Figure 6-2  Experiment Setup Window

6.1 Marker Setup
Describe the markers connected to your system—both individual markers 
and those attached to a rigid body. 
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1. Click the Marker Setup tab.

Figure 6-3  Optotrak 3020 Marker Setup Tab

2. Enter the Total Number of Markers Per Strober Port. For 
example, if you have two rigid bodies with six markers each plugged 
into strober port 1, you would assign the value 12 to Port 1.

Make sure that you account for empty channels on any connected 
strober. For instance, if you have two 6-channel strobers daisy 
chained on Port 1 and you have connected three markers on the first 
strober and five markers on the second strober, you should specify 11 
(6+5) as the total number of markers on Port 1. 

3. (Optional) To rename markers, or to apply a frame of reference to a 
particular marker that is different than that of the global coordinate 
system, click Individual Marker Settings. The following dialog 
appears:
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Figure 6-4  Individual Marker Settings

This dialog is automatically populated with all the markers entered 
for each strober port. To change a marker’s frame of reference, select 
a new Frame of Reference from the drop-down list (if this option is 
available). Click OK when you are finished. 

What is a frame of reference? Frame of reference refers to the 
coordinate system within which a marker is being tracked and 
measured. By default, markers are measured relative to the global 
coordinate system; however, you can change this if you want to 
know the location of a marker relative to another object, typically 
another rigid body or tool already defined in the experiment. (A 
marker will be reported as missing if its reference object goes 
missing.) All markers belonging to a rigid body will be changed if 
that rigid body has its frame of reference changed to that of another 
rigid body. 

Note You can rename markers in this window by double-clicking on a marker 
and typing in its new name. 
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4. Set the Marker Power using the slider provided. 

What is marker power? Marker power is the overall “brightness” 
of a marker. The marker power value represents the combination of 
both marker voltage and duty cycle. The minimum marker power 
value (0%) represents 7.0 V at a 10% duty cycle. The maximum 
marker power value (100%) represents 12.0 V at an 85% duty cycle. 

If marker power is set too low, the Position Sensor may not be able to 
detect a marker in the measurement volume. For example, marker 
power may need to be higher if the markers are at the back of the 
measurement volume. Inversely, if a marker is at the front of the 
measurement volume, the marker power must be lower so as not to 
saturate the Position Sensor. The Raw Data view can be used to 
check if the marker emits sufficient IR signal; refer to “Raw Data 
View” on page 87 for details. 

5. Set the Marker Frequency. 

What is marker frequency? Marker frequency is the rate at which 
markers are activated within a frame. Increasing marker frequency 
increases the rate at which marker positions are measured within a 
frame. This may be useful when tracking fast moving objects. 
However, a high marker frequency reduces the effectiveness of 
marker power (making it more difficult for the Position Sensor to 
detect markers at the back of the measurement volume). If you must 
use a high marker frequency, you should also increase the duty cycle.

6. (Optional) Click Advanced Marker Settings to adjust marker 
voltage and duty cycle directly (instead of simply applying a 
combined Marker Power value):

Figure 6-5  Advanced Marker Settings Dialog

What is duty cycle? Duty cycle is the percentage of the marker 
period (time between two markers being activated) during which a 
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marker is activated. If this value is set too high, the life span of the 
marker may be diminished; an activated marker in your hand should 
not feel hot. 

What is marker voltage? Marker voltage is the voltage that strobers 
use to activate markers. If this value is too high, the life span of the 
marker may be diminished. If this value is too low, there may not be 
enough marker power for the Position Sensor to be able to detect the 
marker in the measurement volume. 

6.2 Rigid Body Setup
Some of the markers you have assigned to a strober may be part of a rigid 
body:

Note You must define all the rigid bodies in your experiment before you collect 
any data. Otherwise, you will not be able to use First Principles to perform 
rigid body calculations.
46 First Principles User Guide - Revision 3



1. Click the Rigid Body Setup tab.

Figure 6-6  Optotrak 3020 Rigid Body Setup Tab

2. To assign a rigid body, click Add. Browse to and select the 
appropriate tool definition file (.rig) that represents the rigid body 
plugged into the system. The software adds the rigid body and its 
relevant tool definition file name to the Connected Tools/Rigid 
Bodies list.

3. Enter the Start Marker — the marker location of the first marker on 
the rigid body, relative to all markers connected to the system. Notice 
that the software provides you with a suggested value. 

Note You can remove rigid bodies from this list by selecting a rigid body and 
clicking Remove. You can also view the contents of a rigid body’s tool 
definition file (.rig) by selecting it from the list and clicking Details.
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How to Add Imaginary Markers to a Rigid Body
Imaginary markers are points assigned to a rigid body where it is difficult 
or undesirable to attach an actual marker. Their locations are appended to 
the rigid body’s tool definition file and are tracked as if they were real 
markers. 

Some rigid bodies include imaginary markers in their tool definition file. 
These markers are “permanent” as their positions are recorded in the tool 
definition file and cannot be edited. These markers are created using NDI 
6D Architect software, as part of the characterization process. 

Some situations call for “temporary” imaginary markers — imaginary 
markers that are associated with a rigid body’s design but that may 
change in location, for instance segment endpoints associated with a 
segment rigid body attached to different subjects. Use First Principles to 
create these temporary points and save them as part of your experiment 
setup.

1. Select a rigid body from the Connected Tools/Rigid Bodies list.

2. Click Points to Digitize. The following window appears:

Figure 6-7  Adding Imaginary Markers

3. Click Add to add placeholders for each imaginary marker your 
experiment requires. 
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4. Double-click each label in turn and rename the imaginary markers as 
desired for your experiment. 

5. In the Use In Origin column, select Yes for each marker you want to 
include when determining the origin. The origin will move to the 
centroid of all selected markers. If no markers are selected in this 
column, the origin will remain unchanged. (Markers may also be 
selected by right-clicking and selecting Use in Origin from the drop-
down list.)

6. In the Use In Axis/Plane column, select the marker(s) you want to 
define as the new X-axis, followed by the marker(s) you want to 
define as the XY plane and XZ plane. If no markers are selected in 
this column, the tool coordinate system orientation will remain 
unchanged. 

7. Click OK. The Imaginary Markers to Digitize dialog closes. If your 
experiment includes an ODAU II, proceed with ODAU II setup 
below, otherwise click Next to continue and complete the session 
setup procedure. (Refer to “Session Setup” on page 68 to complete 
the session setup.)

6.3 ODAU II Setup
You might also have Optotrak Data Acquisition Units II (ODAU IIs) 
connected to the Optotrak System, to record additional data about your 
experiment, in conjunction with marker data. For example, your 
experiment may involve capturing marker data attached to a subject’s 
legs. At the same time, your experiment might also employ a force plate 
to record analog signals created when the subject walks across it. 

Note These instructions assume that you understand the concepts and 
terminology used in the operation of ODAU II devices. For more 
information, see the “Data Acquisition Unit II Guide”.
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1. Click the ODAU Setup tab. 

Figure 6-8  ODAU Setup Tab

2. From the list of ODAU Units Detected, select an ODAU unit. Its 
information is loaded into the fields provided. 

3. Set the Frame Frequency to the frequency at which the ODAU II 
will record frames of data. By default, this value is set at 100 Hz. 

4. In the Analog Input Settings section:

• from the drop-down list, indicate whether the Input Mode is 
differential or single-ended. 

• indicate the Number of Analog Channels that the ODAU II 
will be recording data from. Without multiplexer boards, the 
maximum value for single-ended connections is 16; the 
maximum value for differential connections 8.
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• from the drop-down list, set the Input Range to the voltage 
range the ODAU II should sample. 

5. (Optional) Click Advanced to access additional settings. The 
following dialog appears:

Figure 6-9  Advanced ODAU II Settings

a) Enter a Scan Frequency. The maximum scan rates vary with the 
Input Range that you have selected:

b) Indicate whether or not there is a Multiplexer Present. 
(Selecting this option changes the Digital Mode options.)

c) Digital Mode: Select the Digital Mode for Port A/Port B from 
the following list of options. 

Table 6-1  Scan Frequency Chart

Input Range (V) Max Recommended Scan Rate (Hz)
-10 to 10 90 000

-2 to 2 90 000

-1 to 1 70 000

-0.1 to 0.1 20 000
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Note The options available depend on whether the Multiplexer Present option 
is selected. The multiplexer uses the first 4 digitized channels.

Table 6-2  Digital Mode - Selection Options

d) Digital Output: Select the Digital Output channels for Port A 
and/or Port B. The corresponding hexadecimal code is 
displayed as selections are made. (These options are only 
accessible if the applicable port has been selected as an output 
from the Digital Mode drop-down list.)

e) Click OK to apply these settings and close the dialog. 

6.4 Setup Completion
When you have entered all applicable settings for your experiment, click 
Next. The Session Setup wizard appears. Refer to “Session Setup” on 
page 68 to complete the session setup.

Multiplexer Present
Port A/Port B

No Multiplexer Present
Port A/Port B

Mux/Off Off/Off

Mux/In In/In

Mux/Out In/Out

Out/Out

In Out/In Out
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7 Experiment Setup for an Optotrak Certus
This section details the procedure required to set up an experiment using 
an Optotrak Certus System. (For details on setting up an experiment 
using an Optotrak 3020 System, refer to “Experiment Setup for an 
Optotrak 3020” on page 41.)

1. As directed by the initial window, set up your experiment by 
plugging in all markers, rigid bodies, tools, and/or ODAU IIs 
required for your experiment.

Figure 7-1  Experiment Setup Initial Window

Note If you have opened a previously created experiment, the software will 
provide you with a list of expected tools, rigid bodies and markers. Check 
your setup against this list before clicking Next.
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2. Click Next when you are ready. The following window appears: 

Figure 7-2  Experiment Setup Window

Use this window to describe to the software the details of each item 
connected to the system.

Note If you have opened a previously created experiment, and have not 
changed the setup that was listed in the previous step, you can click Next 
to skip past this window. Alternatively, you can use this window to 
describe changes that you have made.  

If you disconnect and then reconnect tool(s) while the system is tracking, 
select File > Edit Experiment and update the experiment setup to detect 
the tool(s).
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7.1 Marker Setup
Describe the strobers, markers and tools connected to your system:

1. Click the Marker Setup tab.

Figure 7-3  Optotrak Certus Marker Setup Tab

The software automatically determines the Total Number of 
Markers Per Strober Port based on the tools plugged into the 
system. Smart Marker configurations are automatically detected. 
Note that the software does not automatically detect any connected 
rigid bodies or individual markers connected to marker strobers, or 
those connected to Optotrak 3020 strober adapters. These must be 
added manually by clicking on Configure Tools/Strobers, as 
described below.

2. Click Configure Tools/Strobers. The following window appears:
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Figure 7-4  Advanced Strober Setup

The software retrieves and displays how the following are connected 
to the system:

• strobers

• tools

• markers

Wireless strober setups are displayed in a configuration tree:
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Figure 7-5  Wireless Strober Setup

Note Make sure that the devices listed reflect your experiment setup. Unplug 
any device not listed, wait two seconds and then plug in the device and 
reconfigure the tool/strober. (Close the Setup window, click Back, then 
click Configure Tools/Strobers.)

Note that the software does not automatically detect any connected 
rigid bodies or individual markers connected to marker strobers, or 
those connected to Optotrak 3020 strober adapters. You must 
manually add these to the setup.

a) Select a strober that has individual markers or a rigid body 
attached to it, and click Add Marker to add the total number of 
markers connected to it—both individual markers and those that 
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are part of a rigid body. To quickly add a number of markers, 
select the Alt-A keys.

b) To remove markers, highlight them and select Remove Marker 
or the Alt-R keys. Alternatively, press the Delete key.

Figure 7-6  Adding Markers to a Marker Strober Setup

3. (Optional) You can rename a marker by double-clicking on its name 
and typing in a new one. 

4. (Optional) You can change a marker’s Frame of Reference. To 
change a marker’s reference, select a new Frame of Reference from 
the drop-down list provided. 

What is a frame of reference? Frame of reference refers to the 
coordinate system within which a marker is being tracked and 
measured. By default, markers are measured relative to the global 
coordinate system; however, you can change this if you want to 
know the location of a marker relative to another object, typically 
another rigid body or tool already defined in the experiment. (A 
58 First Principles User Guide - Revision 3



marker will be reported as missing if its reference object goes 
missing.) All markers belonging to a rigid body will be changed if 
that rigid body has its frame of reference changed to that of another 
rigid body.

Changing Marker Firing Sequences
Markers are fired in the order they are listed. You can indirectly change 
this order by changing the Marker Port address of the markers in 
question.

Individual Markers

1. Double-click an individual marker’s Marker Port entry. 

2. Type in a new number to change that marker’s Marker Port. 

Note Only change the Marker Port entry on markers that are associated with a 
Marker Strober. Changing the Marker Port entry on any other markers 
may prevent the markers from firing.

Rigid Body Markers

All markers associated with a rigid body must be fired consecutively; you 
should not change their firing sequence.

Smart Markers

Smart Markers are automatically assigned Marker Port numbers and they 
cannot be changed.

Tool Markers

Tool markers are automatically assigned Marker Port numbers according 
to their placement in the tool’s internal wiring. 

Note Do not change the port order on tool markers, as the tools will go 
missing.
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Changing Marker Power/Frequency
On the Marker Setup tab:

1. Set the Marker Power using the slider provided. 

What is marker power? Marker power is the overall “brightness” 
of a marker. The marker power value represents the combination of 
both marker voltage and duty cycle. The minimum marker power 
value (0%) represents 7.0 V at a 10% duty cycle. The maximum 
marker power value (100%) represents 12.0 V at an 85% duty cycle. 

If marker power is set too low, the Position Sensor may not be able to 
detect a marker in the measurement volume. For example, marker 
power may need to be higher if the markers are at the back of the 
measurement volume. Inversely, if a marker is at the front of the 
measurement volume, the marker power must be lower so as not to 
saturate the Position Sensor. The Raw Data view can be used to 
check if the marker emits sufficient IR signal; refer to “Raw Data 
View” on page 87 for details. 

2. Set the Marker Frequency. 

What is marker frequency? Marker frequency is the rate at which 
markers are activated within a frame. Increasing marker frequency 
increases the rate at which marker positions are measured within a 
frame. This may be useful when tracking fast moving objects. 
However, a high marker frequency reduces the effectiveness of 
marker power (making it more difficult for the Position Sensor to 
detect markers at the back of the measurement volume). If you must 
use a high marker frequency, you should also increase the duty cycle.

3. (Optional) Click Advanced Marker Settings to adjust marker 
voltage and duty cycle directly (instead of simply applying a 
combined Marker Power value):
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Figure 7-7  Advanced Marker Settings Dialog

What is duty cycle? Duty cycle is the percentage of the marker 
period (time between two markers being activated) during which a 
marker is activated. If this value is set too high, the life span of the 
marker may be diminished; an activated marker in your hand should 
not feel hot. 

What is marker voltage? Marker voltage is the voltage strobers use 
to activate markers. If this value is too high, the life span of the 
marker may be diminished. If this value is too low, there may not be 
enough marker power for the Position Sensor to be able to detect the 
marker in the measurement volume. 

7.2 Rigid Body Setup
.rig files are automatically created and added for any connected/detected 
tools (.rom). However, you must add .rig files for any connected rigid 
body attached to a strober that does not automatically detect tools (such 
as the Optotrak 3020 strober adapter or marker strober), as the system 
cannot automatically detect these. 

Note If you are planning to incorporate an Optotrak 3020 digitizing probe in 
your experiment, you must add it at this stage. This is to enable the 
correct option during Digitize Probe setup.  
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1. Click the Rigid Body Setup tab. The following window appears:

Figure 7-8  Optotrak Certus Rigid Body Setup Tab

2. To assign a rigid body, click Add. Browse to and select the 
appropriate tool definition file (.rig) that represents the rigid body 
plugged into the system. The software adds the rigid body and its 
information to the Connected Tools/Rigid Bodies list.

3. Enter the Start Marker—the marker location of the first marker on 
the rigid body, relative to all markers connected to the system. Notice 
that the software provides you with a suggested value. 

Note You can remove rigid bodies from this list by selecting a rigid body and 
clicking Remove. You can also view the contents of a rigid body’s tool 
definition file (.rig) by selecting it from the list and clicking Details.

How to Add Imaginary Markers to a Rigid Body
Imaginary markers are points assigned to a rigid body where it is difficult 
or undesirable to attach an actual marker. Their locations are appended to 
the rigid body’s tool definition file and are tracked as if they were real 
markers.
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Some rigid bodies include imaginary markers in their tool definition file. 
These markers are “permanent” as their positions are recorded in the tool 
definition file and cannot be edited. These markers are created using NDI 
6D Architect, as part of the characterization process. 

Some situations call for “temporary” imaginary markers — imaginary 
markers that are associated with a rigid body’s design but that may 
change in location, for instance segment endpoints associated with a 
segment rigid body attached to different subjects. Use First Principles to 
create these temporary points and save them as part of your experiment 
setup.

1. Select a rigid body from the Connected Tools/Rigid Bodies list.

2. Click Points to Digitize. The following window appears:

Figure 7-9  Adding Imaginary Markers

3. Click Add to add placeholders for each imaginary marker your 
experiment requires. 

4. Double-click each label in turn and rename the imaginary markers as 
desired for your experiment. 

5. In the Use In Origin column, select Yes for each marker you want to 
include when determining the origin. The origin will move to the 
centroid of all selected markers. If no markers are selected in this 
column, the origin will remain unchanged. (A marker may also be 
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selected by right clicking and selecting Use in Origin from the drop-
down list.)

6. In the Use In Axis/Plane column, select the marker(s) you want to 
define as the new X-axis, followed by the marker(s) you want to 
define as the XY plane and XZ plane. If no markers are selected in 
this column, the tool coordinate system orientation will remain 
unchanged. 

7. Click OK. The Imaginary Markers to Digitize dialog closes. If your 
experiment includes an ODAU II, proceed with ODAU II setup 
below; otherwise, click Next to continue and complete the session 
setup procedure. (Refer to “Session Setup” on page 68 to complete 
the session setup.)

7.3 ODAU II Setup
You might also have Optotrak Data Acquisition Units II (ODAU IIs) 
connected to the Optotrak System, to record additional data about your 
experiment, in conjunction with marker data. For example, your 
experiment may involve capturing marker data attached to a subject’s 
legs. At the same time, your experiment might also employ a force plate 
to record analog signals created when the subject walks across it. 

Note These instructions assume that you understand the concepts and 
terminology used in the operation of ODAU II devices. For more 
information, see the “Data Acquisition Unit II Guide”.
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1. Click the ODAU Setup tab. 

Figure 7-10  ODAU Setup Tab

2. From the list of ODAU Units Detected, select an ODAU II unit. Its 
information is loaded into the fields provided.

3. Set the Frame Frequency to the frequency at which the ODAU II 
will record frames of data. By default, this value is set at 100 Hz. 

4. In the Analog Input Settings section:

• from the drop-down list, indicate whether the Input Mode is 
differential or single-ended. 

• indicate the Number of Analog Channels that the ODAU II 
will be recording data from. Without multiplexer boards, the 
maximum value for single-ended connections is 16; the 
maximum value for differential connections 8.

• from the drop-down list, set the Input Range to the voltage 
range the ODAU II should sample. 

5. (Optional) Click Advanced to access additional settings. The 
following dialog appears:
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Figure 7-11  Advanced ODAU II Settings

a) Enter a Scan Frequency. The maximum scan rates vary with the 
Input Range that you have selected:

b) Indicate whether or not there is a Multiplexer Present. 
(Selecting this option changes the Digital Mode options.)

c) Digital Mode: Select the Digital Mode for Port A/Port B from 
the following list of options. 

Note The options available depend on whether the Multiplexer Present option 
is selected. The multiplexer uses the first 4 digitized channels.

Table 7-1  Scan Frequency Chart

Input Range (V) Max Recommended Scan Rate (Hz)
-10 to 10 90 000

-2 to 2 90 000

-1 to 1 70 000

-0.1 to 0.1 20 000
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Table 7-2  Digital Mode — Selection Options

d) Digital Output: Select the Digital Output channels for Port A 
and/or Port B. The corresponding hexadecimal code is 
displayed as selections are made. (These options are only 
accessible if the applicable port has been selected as an output 
from the Digital Mode drop-down list.)

e) Click OK to apply these settings and close the dialog. 

7.4 Setup Completion
When you have entered all applicable settings for your experiment, click 
Next. The Session Setup wizard appears. Refer to “Session Setup” on 
page 68 to complete the session setup.

Multiplexer Present
Port A/Port B

No Multiplexer Present
Port A/Port B

Mux/Off Off/Off

Mux/In In/In

Mux/Out In/Out

Out/Out

In Out/In Out
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8 Session Setup
The final step in the experiment setup is session setup. The Session Setup 
wizard appears when you select Next from Experiment Setup. Session 
setup consists of:

• Specifying the collected data location

• Digitizing imaginary markers (If any points to be digitized have 
been defined in the rigid body part of the Experiment Setup 
wizard.)

These steps are detailed in the following paragraphs.

8.1 Collected Data Location
The Collected Data Location window allows you to name the session 
and specify the directory location. 

Figure 8-1  Collected Data Location
68 First Principles User Guide - Revision 3



1. Browse to the desired directory.

2. Type in a name for the session.

The data location line is automatically filled in to show the data 
location.

Check Use Timestamp to make directory name unique to add the 
time to the directory name.

3. Click Next. If any points to be digitized have been defined in the 
rigid body part of the Experiment Setup wizard, the Digitizing 
Probe Setup window appears. (See “Digitizing Imaginary Markers” 
on page 70.). Otherwise, the Session Setup is complete and the 
application opens in Text View displaying the real-time data 
measured by the system. Refer to “Viewing Experiment Data” on 
page 82.
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8.2 Digitizing Imaginary Markers

Figure 8-2  Digitizing Probe Setup

To digitize imaginary markers, follow the procedure detailed below:

1. Select the Digitizing probe information from one of the following 
three options:

• (Certus only) Select the Add an extra digitizing probe to my 
experiment setup (Certus only) option. 

a) Plug in the probe to any free tool strober port. (If there is no tool 
strober port available, add another tool strober with a probe 
attached anywhere in the configuration.)

b) Click Detect Tools to identify the probe you have just plugged 
in. (It will always find this probe.)
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• (Optotrak 3020 only) Select the Add an extra digitizing probe 
to my experiment setup (3020 only) option to select a tool 
definition that matches the probe:

a) Plug in the probe to the port that is pre-selected by the 
application, as indicated in the Port drop down list. (If you did 
not connect the tool to the SCU port pre-selected by the 
application, select the appropriate Port from the drop down list.)

b) Browse to, and select, the appropriate rigid body file for the 
chosen digitizing probe. 

c) The Marker field displays the number of markers associated 
with the selected rigid body file. 

d) The Start Marker field displays the next available marker 
position. 

• Check the Digitizing probe is already part of the experiment 
setup option. From the drop down list, select the tool that you 
will use as the digitizing probe. (This list contains only rigid 
bodies that do not contain imaginary markers to be digitized.) If 
this option is “greyed out” and you are using a Certus system, 
make sure that you added the probe during the Rigid Body Setup 
procedure. Refer to “Rigid Body Setup” on page 61.

2. Check the I want to re-pivot the probe before using it option if you 
want to re-pivot the probe. 

3. Select Next. 

• If you checked the pivoting option, the pivot collection dialog 
will open. Refer to “Pivot Procedure” on page 74. Complete the 
pivot procedure and then continue with Step 4. 

• If you did not check the pivoting option, the following dialog 
appears. Continue with digitizing the imaginary markers in Step 
4. 
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Figure 8-3  Digitizing Imaginary Markers

4. Select a Digitizing Method:

• Select F5 if you want to use either First Principles’ Digitize 
Point button or the F5 shortcut key to initiate a collection.

• Select Switch if your digitizing tool/rigid body design includes a 
switch that when activated, initiates a collection. 

• Select Distance if you wish to simply move the digitizing probe 
and have the software automatically collect a point at specific 
distance intervals. Enter the desired interval in millimetres. 

• Select Time Interval if you wish to simply move the digitizing 
tool/rigid body and have the software automatically collect a 
point at specific time intervals. Enter the desired interval in 
seconds. 
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• Select Stability if you want First Principles to initiate a 
collection when the tool or rigid body has stopped moving for 
about two seconds, relative to the digitized tool/rigid body. 

5. At this point, the system is producing realtime data of the digitizing 
probe and the tool containing the marker being digitized. Notice the 
spatial view showing the markers in the measurement volume. 

Using the spatial view for guidance, move the probe into the 
measurement volume and place its tip at the first point.

6. Using whatever digitizing method you selected, collect a snapshot of 
that point. An imaginary marker is created and added to the spatial 
view (in a different colour than existing markers). 

The bottom of the dialog displays a progress bar that increments each 
time you digitize a point. Below the progress bar, a prompt displays 
the name of the point you are digitizing. This is the name you 
specified when you set up the experiment. 

The counter at the left of the progress bar shows the current point 
number out of the total number.  

If necessary, select < Previous Point to go back one point. 

7. Repeat this process until you have finished creating all desired 
imaginary markers. The Next button will now be enabled. After all 
points have been digitized, you can highlight and change the current 
point by selecting the sequence number field and entering the 
required point. For instance, you may wish to re-digitize a specific 
point because the subject moved.

8. Click Next. The dialog closes and the experiment starts with a 
default text view displaying real-time data.

8.3 What Next?
Now that you are collecting data, you will want to customize the views. 
Refer to “Viewing Experiment Data” on page 82. 
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9 Pivot Procedure
First Principles provides a stand-alone pivot utility that enables you to 
calculate a tool tip offset without having to run or start an experiment. 
One example of use would be if a tool or rigid body is dropped and you 
want to quickly apply a new tool tip offset. 

The pivot procedure is as follows:

1. From the main menu, select Utilities > Pivot Tool/Rigid Body. The 
following appears:

Figure 9-1  Pivot Procedure - Initial Dialog

2. Following the on-screen instructions, make sure that the tool or rigid 
body is connected to port 1 on the SCU and that no other markers, 
tool, or rigid bodies are connected to the system. 

3. Click Next. The following window appears:
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Figure 9-2  Pivot Procedure - File Location

4. Browse to, and select, the appropriate tool definition file. 

5. Click Next. The following dialog appears:
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Figure 9-3  Pivot Collection Dialog

The pivot collection dialog displays a 3D spatial view that allows 
you to visualize the tool or rigid body as you perform the pivot 
procedure. 

Note You can manipulate the spatial view with the toolbar located on the 
dialog. For further information, refer to “Using the Spatial View” on 
page 91.

The marker x, y and z positions are shown on the left of the dialog. 
The indicators in the left column show green when the associated 
marker is visible to the Position Sensor and red when not in view. 
Transformation data for the tool or rigid body is displayed at the 
bottom of the dialog.

6. (Optional.) To adjust the pivot algorithm parameters, complete this 
step; otherwise, proceed to step 8. Click Pivot Algorithm 
Parameters.... The following dialog appears:
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Figure 9-4  Pivot Parameters Dialog

7. Select the Use pivot pass parameters checkbox to use the pivot pass 
parameters. If this option is not checked, the pass parameters will not 
be used when the pivot results are calculated. Refer to Table 9-1 and 
set the parameters as desired. (Selecting Reset to Defaults will reset 
the parameters to default values.) 

Table 9-1  Pivot Parameters

Pivot 
Parameter Description

Maximum 3D 
RMS Error

This field defines the acceptable threshold for 3D RMS 
Error values produced by a pivot. The 3D RMS  Error is 
produced by applying the result of the pivot procedure to 
each frame of the pivot procedure, and calculating an 
overall RMS error for the collection. 

Maximum 3D 
Error

This field defines the acceptable threshold for 3D error 
values produced by a pivot. The 3D Error is produced by 
applying the result of the pivot procedure to each frame of 
the pivot procedure, and calculating an error for that 
frame. 

Minimum 
Major Angle

This field defines the acceptable threshold for a major 
angle produced during a pivot. The major angle is the 
greatest angle the tool was moved during the pivot 
procedure. 
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8. Set a Collection Time of between 5 s and 60 s and a Delay of 
sufficient time (between 0 s and 60 s) to allow you to correctly 
position the tool or rigid body and begin the collection.

9. Position the tool or rigid body in the measurement volume with its 
tool-tip placed on a fixed point (such as a divot in a pivot block). 
Ensure that the markers are visible and that the software is reporting 
valid transformation of the tool.

10. Click Collect to begin the data collection trial.

11. As the system collects the data, continuously pivot the tool or rigid 
body back and forth and side to side, with its tip remaining stationary 
at the fixed point. Ideally, the angles of the pivot movements should 
be between 30° and 60°. 

Note It is very important that the tip remains stationary while the tool or rigid 
body is being pivoted. The design of the pivot block should take into 
account the shape of the tool’s end-tip. For more information about 
designing a pivot block, contact NDI.

12. At the end of the collection period, the Pivot Collection dialog will 
show either a pass or a fail. An example of a successful pivot is 
shown on page 79:

Minimum 
Minor Angle

This field defines the acceptable threshold for a minor 
angle produced during a pivot. The minor angle is defined 
as being orthogonal to the plane of the major angle.

Pivot 
Parameter Description
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Figure 9-5  Successful Pivot Dialog

13. To view the pivot results click View Details. The following dialog 
appears:
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Figure 9-6  Pivot Results Dialog

Note If the pivot failed, the results dialog will appear by default and any errors 
or angle information that is outside parameters is displayed in yellow. 

The pivot results dialog provides the following information:

Table 9-2  Pivot Results

Results Description
Calculated Tip 
Offset

This section displays the x, y, and z position of the tool 
tip, relative to the origin of the tool’s local coordinate 
system.

Error 
Information

This section displays the 3D RMS, mean, and maximum 
3D errors of the collection, in millimetres.

Angle 
Information

This section displays the maximum and minimum angles 
of the pivot you performed. The maximum angle is the 
greatest angle created by the pivot movements; the 
minimum angle is defined as being orthogonal to the 
plane of the maximum angle.
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Note If the Use pivot pass parameters option was not checked, the pivot 
procedure will pass, but any error or angle information that is outside 
parameters will be highlighted in yellow. 

14. Click Finish to apply the calculated tip offset and close the dialog.
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10 Viewing Experiment Data
First Principles provides a comprehensive list of options for viewing 
experiment data. A view is a window that allows you to see data in real 
time, as it is produced by the Optotrak System and the experiment 
setup. To add a new view, simply select it from the View menu. You can 
customize views in several ways: 

• select the type of view to display 

• select how many views are open

• select the type of data to display in each view

When you collect a set of data, your customized view settings will be 
recorded along with the data they display. You may play back data 
collections using the same views in which they were originally displayed. 
(For information on data collection and playback, refer to “Data 
Collection and Playback” on page 106.) 

An example of the main experiment window is shown in “Main 
Experiment Window” on page 83 below. In this example three views 
have been selected; two text views and one spatial view. You may view as 
many different views as desired. The following view options are 
provided:

• text view

• missing data view

• raw data view

• spatial view

• strip chart view

• probe view

• video view

Each view is described in detail in the following paragraphs. 

To increase viewing area, the toolbar and control bar may be toggled as 
desired. Select View > Toolbar or View > Control Bar and click to 
toggle on and off. 
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Figure 10-1  Main Experiment Window

10.1 Text View
Select View > Text View from the main menu bar. The text view provides 
a table listing data and their corresponding realtime values as their 
sources are tracked in the measurement volume. An example of a text 
view is shown in Figure 10-2.

Figure 10-2  Text View
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You can choose to display markers, rigid bodies and tools, the results of 
calculations, and ODAU II output. In the example (“Text View” on 
page 83), the view displays tools, markers and ODAU II data. To select 
the data to display, right-click within the view window. The following 
menu appears:

Figure 10-3  Text View Options

Click the data types filter to toggle them on and off. Alternatively you can 
select the desired data types filter options from the View option on the 
main menu bar.

You can also define the way that data is displayed. Click either View 
Properties from the Text View Options dialog or View > View 
Properties from the main menu bar. The following dialog appears:

Figure 10-4  Text View Properties Dialog

Use the radio buttons to select the desired rotation settings and set the 
decimal point precision as desired within the range 0-16.

10.2 Missing Data View
Select View > MissingData View from the main menu bar. The missing 
data view provides a strip chart-like display of markers being tracked in 
real time, flagging those that go missing. This facility is useful in 
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identifying any component of the system that is not collecting data. An 
example of a missing data view is shown in Figure 10-5:

Figure 10-5  Missing Data View

In the example, two tools and sixteen markers are selected. The legend at 
the top of the window relates to the data on the chart. It can be seen that 
both tools and all but markers one and two had periods when data was 
missing, denoted by the gaps in the data lines. 

You can define the way that data is displayed. Right-click within the 
missing data view and select View Properties or select View > View 
Properties from the main menu bar. The following window appears:
First Principles User Guide - Revision 3 85



Figure 10-6  Missing Data View Properties — Graph Settings Tab

Graph Settings
The missing data view default settings are adequate for most situations, 
but they may be configured as follows:

1. From the Line drop-down list, select the object whose graph view 
properties you want to edit. (For example, the object may be a 
marker, a tool, or an ODAU II channel.)

2. From the Style drop-down list, select the desired line style. (Notice 
that the adjacent representative graphic view changes to reflect your 
selection.)

3. From the Width options, select the desired width, in pixels. 

4. From the Colour drop-down list, select the desired line colour. 

5. In the Graph section, select the Display Legend and History 
options as desired. (History is set in seconds from 1 s to 3600 s.)
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6. Select the Datasets tab. The following window appears:

Figure 10-7  Missing Data View Properties — Dataset Tab

The Datasets tab allows you to select which data to monitor. You can 
select data in two ways:

1. Select the check box directly next to the desired data source. (You 
can also use the default Select All and Clear All buttons as desired.)

2. Follow the on-screen instructions and type the item numbers in the 
Items line. Click Apply.

When you have made your selections, click OK to close the window and 
return to the missing data view. 

10.3 Raw Data View
The raw data view provides a text view of the full raw data being 
produced by the system, before it is processed into 3D and 6D data. The 
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software can report, in real time, the following data for each sensor on the 
Position Sensor:

Centroid (0 to 2047) is the centre point of an imagined three-dimensional 
volume created by the selected markers. The mean position of the 
infrared light emitted by a marker across an Optotrak sensor. 

Peak (0 to 100) represents the strength of a marker’s signal received by 
the sensor. 

Amplification represents the amount of “boost” required to obtain a 
marker reading. A value of 0% indicates that a minimum amount of 
amplification was required for sensor to detect the marker, while a value 
of 100% indicates that the maximum amount of amplification was 
required. If markers have amplification levels close to 100%, these 
markers may be too dim for the Position Sensors to determine their 
positions. If markers have amplification levels close to 0%, these markers 
may be too bright for the Position Sensors to determine their positions. 
You can adjust marker power in Settings > Marker Settings/Frequency. 

Code indicates the status of the signal being received from a marker. For 
example, if a marker is missing, the code for that marker will indicate the 
reason that the Position Sensor cannot determine its position. The 
following table lists these codes: 

Table 10-1  Raw Data View — Code Definitions

Error Definition
Centroid acceptable The sensor successfully calculated the marker centroid.

Waveform too wide The amount of light visible is above the noise threshold for 
the system to determine the marker centroid. The marker is 
too close to the Position Sensor. Move the marker farther 
away from the Position Sensor to correct this problem.

Peak too small The marker signal is too weak. This may be due to the marker 
being obscured or the marker having insufficient power. 
Increase the strober voltage and/or duty cycle to strengthen 
the marker signal. For further information, refer to “Experi-
ment Setup for an Optotrak 3020” on page 41 or “Experiment 
Setup for an Optotrak Certus” on page 53 as appropriate.
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Two examples of the raw data view are shown in “Raw Data View” on 
page 90. In the top example, Centroid and Peak + Amplification are 
selected. In the lower example, Code is selected. Also, in the lower 

Peak too large The marker signal is too strong. Decrease the strober voltage 
and/or duty cycle to weaken the marker signal. For further 
information, refer to “Experiment Setup for an Optotrak 
3020” on page 41 or “Experiment Setup for an Optotrak Cer-
tus” on page 53 as appropriate.

Waveform out of vol-
ume

The marker waveform is partially out of the field of view of 
the sensor. Check the measurement volume of the Position 
Sensor on the name plate located at the back. (See the system 
user guide for details.) Relocate the marker so that the marker 
waveform is within the measurement volume. 

Fell behind The sensor fails to process the current marker's signal before 
required to process the next marker's signals. Lower the 
marker frequency to correct this problem. For further infor-
mation, refer to “Experiment Setup for an Optotrak 3020” on 
page 41 or “Experiment Setup for an Optotrak Certus” on 
page 53 as appropriate.

Bad last centroid Interpolation cannot be carried out because a marker was not 
visible in the previous frame. This would only occur if the 
collection was configured to perform interpolation on the raw 
sensor values.

Buffer full The internal centroid data buffer on the sensor is full and the 
sensor fails to store the current marker data. Lower the frame 
rate to correct this condition. For further information, refer to 
“Experiment Setup for an Optotrak 3020” on page 41 or 
“Experiment Setup for an Optotrak Certus” on page 53 as 
appropriate.

Missed sensor The sensor has determined that it has missed a time control 
signal from the Optotrak System Control Unit, probably 
because of a communication error.

Corrupted data The sensor failed to process the marker data due to an internal 
communication error.

Has reflection Multiple centroids were detected. This is usually the result of 
reflection caused by a highly reflective surface, which was 
detected by the sensor as an IR source. Other sources of IR in 
the room can also cause this.

Table 10-1  Raw Data View — Code Definitions (Continued)

Error Definition
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example markers were obscured to produce the Peak too small error. Use 
the check-boxes at the top of the window to select the data you wish to 
view. 

Figure 10-8  Raw Data View

10.4 Spatial View
The spatial view provides the functionality to visualize experiments by 
means of 3D and 2D graphical panes, showing views of the markers in 
the measurement volume. The default spatial view is the 3D pane. An 
example of the 3D pane is shown below:

Note If you experience any problems with the graphical panes, review the 
Windows settings related to your graphics card. Changing these settings 
may solve the problem.
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Note Selecting View>Video View overlays real-time video over the spatial view. 
For details on the video view, see “Video View” on page 102. 

This view can display only 3D and 6D data, including calculations. It 
cannot display scalar values such as ODAU II voltages and scalar 
calculations. 

Figure 10-9  Spatial View — 3D Pane

Using the Spatial View
The spatial view window incorporates a toolbar. This toolbar allows you 
to control the major functionality of the view with a single mouse click 
on the appropriate icon. You can toggle the toolbar with the arrow button 

Markers Global Coordinate 
System
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on the left of the toolbar. Refer to Table 10-2 for a description of each 
icon. 

Marker Views
The spatial view can display markers in a number of different formats. 

The formats are toggled with the  icon as described above. The 
various formats are as follows:

• displays as a point

• displays as a number, representing the marker number, as 
defined in the experiment setup

• displays as the marker label defined in the experiment setup. 
This option will also display any 3D or 6D information that is 
displayed in the text view

Table 10-2  Spatial View Toolbar Icons

Icon Description
Toggles the menu display

Resets the view back to the coordinate system origin

Moves the view to the marker centroid (the geometric 
centre of the markers) 

Locks or unlocks the view to the marker centroid

Toggles the coordinate system frame of reference in 90° 
steps

Toggles between different marker display types

Launches the navigation help
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• displays as large 3D boxes. This option is useful for viewing the 
spatial view from a distance.

• makes markers invisible, which may be useful if lines are drawn 
between markers.

The markers can be selected and de-selected by clicking. The marker will 
change colour when it is selected. This feature is useful in designating 
markers of particular interest. 

3D and 2D Views
When it is first selected, the spatial view defaults to a 3D pane. Double-
click that pane to display the three corresponding 2D panes, in addition to 
the 3D pane. Double-click any pane to maximize that pane in the window. 
Another double-click will again display all panes. An example of the 
spatial view with both 3D and 2D panes is shown in Figure 10-10. 

The 2D panes show the top, bottom and side views of the markers. The 
coordinate system is also displayed and this can be useful for orientation. 
The coordinates and scale of each pane are displayed in the bottom left 
hand corner of each pane.
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Figure 10-10  Spatial View — 3D and 2D Views

Manipulating Views
There is considerable flexibility provided to allow you to manipulate the 
spatial view to best meet your requirements. Each 3D and 2D pane can be 
manipulated independently, and easily, by means of mouse and keyboard 
shortcuts. 

2D View

3D View

2D View

2D View
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The following table describes the keyboard and mouse shortcuts you can 
use to manipulate the 3D and 2D panes:

Drawing Lines Between Markers
The spatial view also provides the functionality for you to draw lines 
between markers. This feature can be useful if you want to visualize the 
relationship between markers. For instance, if markers are placed on a 
limb, then joining the markers along the limb at the joints will aid in 
visualizing movement of the limb. An example of a 3D pane with lines 
between markers is shown in Figure 10-11. 

Table 10-3  Spatial View — Keyboard and Mouse Shortcuts

To: Do this:
Zoom in/out Use the mouse scroll wheel, or hold ‘Z’ + 

left mouse button + drag

Move view Hold left mouse button + drag

Rotate view Hold ‘Ctrl’ + left mouse button + drag 
(This control is not applicable in the 2D 
views.)

Reset view to the tool origin Press ‘O’

Reset view to geometric 
centre of markers

Press ‘C’

Lock/unlock the view to 
geometric centre of markers

Press ‘L’

Maximize/minimize a pane Double-click the pane

Toggle anti-aliasing Press ‘~’

Toggle grid Press ‘G’
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Figure 10-11  Spatial View — Drawing Lines Between Markers

To draw lines between markers:

1. Hold the ‘Shift’ key and click the first marker. The marker will 
“flash” to show it is selected. 

2. Move to the second marker and click to select. A line will appear 
between the two markers. Continue selecting the desired markers in 
this way. 

3. After the final selection, hold down the ‘Shift’ key and click in the 
pane away from the markers. The “flashing” marker will become 
deselected. 

To change the colour of the lines between markers, right-click the line 
and select the desired colour from the palette that appears. (It is possible 
to define custom colours in this palette using normal Windows 
conventions.) The current line and all subsequent lines will be drawn in 
the latest selected colour. 
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To delete a line, select it and press the ‘Delete’ key

10.5 Strip Chart View
The strip chart view provides a graphical representation of several traces 
of data, to which you can add or remove as desired. You can customize 
colours, names, and ranges. An example of a strip chart view is shown in 
Figure 10-12. In this example the x, y, and z positions are displayed for 
each of four markers. 

Figure 10-12  Strip Chart View

Similar to the other views, you can configure the strip chart view to 
display various forms of data. Right-click and, from the list of options, 
select the data to display. The list of view options can also be accessed 
from View on the main menu bar. The view options can be further 
defined from the View Properties option, described in the following 
paragraphs. 
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Strip Chart Options
To set the view options for the strip chart view:

1. Right-click the strip chart view and select View Properties. 
Alternatively select View > View Properties from the main menu 
bar. The following dialog appears:

Figure 10-13  Strip Chart View — Graph Settings

2. Select the data line that you want to edit from the Line drop-down 
list. 

3. Select the line Style, Width and Colour as desired. Your revised 
settings are displayed in the preview window.

4. In the Y-Axis section, select Auto Scale Up as desired. With this 
selection checked, all data lines are auto-scaled upwards (it does not 
scale down). If it is de-selected, you must set the Y-axis scale, in the 
Max and Min fields, for each data line.  
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5. In the Graph section, select Common Y-Axis, Show Grid and 
Display Legend as desired. If you select Common Y-Axis, all data 
lines will be set to a common Y-axis. This feature is useful if you 
want to compare relative measurements between two or more data 
lines. In History, select the time that you want to display, within the 
range 1 s to 3600 s (1 hour).

6. In the Rotation Settings section, select the Angle Units and Format 
as desired. 

7. Click OK to apply your settings and return to the strip chart view, or 
click Datasets to edit the data. If you choose to edit the datasets, the 
following window appears:

Figure 10-14  Strip Chart View — Datasets

The Datasets window allows you to select what items and what data 
from those items, to display on the strip chart. In the example above, it 
can be seen that a rigid body position (x, y, z) and transformation (q0, qx, 
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qy, qz) is selected and that individual markers are de-selected. You can 
select data in a number of ways:

• Use the Select All and Clear All buttons to select or clear all 
items.

• Click an item or sub-item to select/deselect it.

• Enter the item and sub-item numbers in the appropriate field and 
click Apply. (The items and subitems are numbered from the top 
of the list.) For example:

To select items 1, 2, 3, 4, 10 and their third subitems enter:

Items: 1-4, 10

Subitems: 3

To select the first and third subitems of all items, enter:

Items: (leave empty)

Subitems: 1, 3

Note Any changes you make in the Dataset window are also applied to the View 
menu.

When you have completed your changes, click OK to apply the changes 
and return to the strip chart view. 

10.6 Probe View
Select View>Probe View from the menu bar. The probe view allows you 
to “capture” or “digitize” random points using any tool. You can then 
copy and paste the points into your desired application, for example, 
Excel, Word, Notepad. You can also add the captured (digitized) points as 
imaginary markers into a rigid body file. The probe can be measured in 
the global frame of reference, or relative to any other tool. An example of 
a probe view is shown below. 

Note The probe view is a general utility that allows you to use the system as a 
3D “rule”. It has no function as part of the experiment process.
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Figure 10-15  Probe View

The probe view is configured and manipulated as follows:

1. Select the probe that you will use to collect data points, from the 
Probe drop-down list. The Probe indicator will “light” as follows:

• Green - The selected probe is in view and tracking correctly

• Red - The selected probe is not in view, or at least one of its 
markers is obscured. The associated x y z coordinates will 
display --- --- ---

• Grey - no probe has been selected

2. Select a reference in which to measure the probe, from the 
Reference drop-down list. The probe can be measured in the global 
frame of reference, or relative to any other (loaded) tool. 

The Reference indicator will “light” as follows:

• Green - Another tool is selected as the frame of reference and is 
tracking correctly

• Red - Another tool is selected as the frame of reference and that 
tool is not in view, or one or more of its markers are obscured

• Grey - (Default) Global frame of reference is selected
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3. The main x, y, z field displays the current coordinates of the probe. 
Select the Capture button or press F5 as required to add the current 
coordinates to the Point list. To delete individual points, select them 
with the left mouse button and press Delete.

To define the capture trigger select View>Options and select the capture 
trigger as follows:

• Select F5 if you want to use either First Principles’ Capture 
button or the F5 shortcut key to initiate a collection.

• Select Distance if you wish to simply move the probe and have 
the software automatically collect a point at specific distance 
intervals. Enter the desired interval in millimetres. 

• Select Time Interval if you wish to simply move the probe and 
have the software automatically collect a point at specific time 
intervals. Enter the desired interval in seconds. 

• Select Stability if you want First Principles to initiate a 
collection when the probe has stopped moving for about two 
seconds, relative to the reference. 

10.7 Video View
The video view provides the functionality to overlay video with the 
motion data, allowing you to see the video of the experiment run 
synchronized with the motion data. If video recording is not included as 
standard on your system (video playback is free), you will need to 
purchase this feature. A prompt will appear during tracking if a key is 
required to activate the feature.

The synchronization of video and motion data can be either simple start/
stop or frame by frame. Start/stop synchronization only requires a 
“webcam” and is sufficient for a visual indication of markers overlaid 
with video. Frame by frame synchronization requires a high specification 
camera and custom cable. Frame by frame synchronization provides very 
precise synchronization of markers and video. Refer to your system user 
guide for details on hardware selection and setup. 
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Using Video View

Note All the controls and features used in video view are identical to those 
used in spatial view. See “Spatial View” on page 90.

Select View>Video View from the menu bar. A video view appears. In 
the example shown in Figure 10-17 there are three video sources, two 
recorded video sources and one camera source. You can select any of the 
available video sources. 

Each time you select View>Video View, a new video view will open. 
Right click on the video view and select the required source from the pop 
up menu.

Figure 10-16 illustrates an example of a recorded video menu and a 
camera video menu. The camera video menu displays resolution settings 
specific to the camera. In addition, right click on Camera Properties... to 
access camera specific settings. 

Figure 10-16  Video Source Menus

If First Principles detects any camera(s) that supports the DirectShow 
interface, they will automatically record video, in addition to motion data. 
To prevent the video from being recorded, disconnect any camera 
connected to the host computer. In this case, the video view content will 
be empty.

In the example shown in Figure 10-17, the controls have been set to 
illustrate varying degrees of video opacity. To adjust video opacity, press 

Recorded Video Camera Video
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“t” on the keyboard, select and hold the left mouse button and move the 
mouse vertically. Video opacity can also be adjusted from the video view 
properties, see below.

As video opacity is increased beyond a certain threshold the spatial 
control buttons become unavailable and “greyed out”. This is to prevent 
the inadvertent movement of the spatial view settings, relative to the 
video. See Video View Properties below for detailed information on this 
feature.

To save your settings for collections or experiments, select Ctrl-s or 
File>Save Experiment or Save Collection.

Figure 10-17  Video View

Video View Properties
To view the video view properties, right click in the required video view 
and select View Properties.... The video view properties dialog appears, 
see Figure 10-18. The first two settings, Default Line Thickness and 
Default Point Size relate to markers in the spatial view, see “Spatial 
View” on page 90. 
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Set the Default Refresh Rate as required. This setting will be applied to 
all subsequent video views that you open. Higher refresh rates will 
require more host computer processing power.

Set the Video Opacity slider as required. Video opacity can also be 
adjusted by pressing the “t” key, clicking and holding the left mouse 
button and moving the mouse vertically. 

Check the Unlock 3D View Manipulation to access the spatial view 
control buttons. This check box is only available at settings below 90% 
opacity. This is to prevent the inadvertent movement of spatial view 
settings. 

Figure 10-18  Video View Properties

10.8 What Next?
Now you have your experiment set up and running, with the views set as 
desired you will want to record and play back data collections. Refer to 
“Data Collection and Playback” on page 106.
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11 Data Collection and Playback
First Principles enables you to record and play back the data you collect 
during experiments. 

The record and playback interfaces are very simple and intuitive. The 
toolbars for both record and playback are context-sensitive and use 
universal controls. 

The record and playback functions are detailed in the following sections.

11.1 Data Collection
First Principles allows you to record all the real-time data with one mouse 
click. The record toolbar is located at the bottom of the main window and 
is active whenever a view of the real-time data is active. 

Figure 11-1  Record Toolbar

To set collection properties, follow the procedure detailed below:

1. Open the view(s) that you want to record. (Refer to “Viewing 
Experiment Data” on page 82.)

2. Right-click the record toolbar and select Collection Properties.... 
The following dialog appears. (Collection properties can also be 
accessed from the main menu bar. Select Collection > Collection 
Properties.)
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Figure 11-2  Collection Properties

3. Set the Collection Duration, within the range 0 s to 99999 s. 

4. Set the Pre-Collection Delay, within the range 0 s to 60 s. (This 
feature can be used to allow time to position the experiment before 
recording begins.)

5. Make sure the Markers Active option is checked. This feature can 
be used to switch markers off when not required. This will maximize 
their life. (This option can also be selected from the record toolbar. 
When the markers are deactivated, the toolbar option will be 
highlighted.)

6. Select Automatic Marker Deactivation as desired. Set the Time 
Period. This option is automatically selected for Smart Markers in 
wireless mode.

7. Select External Trigger as desired. If you select this option, the 
record button is greyed out and the record function is controlled by 
the SCU. Refer to the system documentation for information on how 
to use the external trigger function.

The external trigger option allows you to define a specific event, for 
example a door opening, to trigger recording. Additionally, when this 
option is selected, you can select Automatically Rearm. This will 
set the system to again trigger recording when the same external 
event occurs. 
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8. Select External Clock if you have applied an external clock to the 
SCU. If you select this option, the application will not respond until 
the SCU receives the clock signal.

9. Select the record button to initiate the data collection and recording. 
The data will be recorded for the selected time period. Select the stop 
button at any time to stop recording.

10. The recorded data will be stored with the name and at the location 
defined during the session setup. The collections will also save all 
views and view settings, so that playback of this collection will look 
the same as when it was recorded. Refer to “Collected Data 
Location” on page 68. The recorded data is stored with a .nco 
extension and automatically exported to the file formats defined in 
Settings > Auto Export. Refer to “Exporting Data” on page 129.

Note The record functionality can also be accessed from the Collection drop-
down menu. 

The first time in each session that you record data, a Session Summary 
dialog will appear. This dialog displays data and the name and location of 
each file you record and the dialog increments as the session progresses. 
This information is useful as a reference for the current session. Double-
click a collection to open that collection. An example of a Session 
Summary is shown below:

Figure 11-3  Session Summary
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11.2 Data Playback
To play back previously recorded data, follow the procedure detailed 
below. 

1. Select File > Open Collection....

2. Browse to and select the desired data collection (.nco extension). The 
recorded collection(s) will open and the playback bar appears.

Figure 11-4  Playback Bar

3. From the drop down box, select the desired playback option:

Collections containing ODAU data have two more options:

4. Right-click the playback bar and select Playback Properties... . The 
following dialog appears. 

real time plays data back in seconds
If the  frame frequency is high, some frames 
may be skipped during playback.

marker frames plays data back in frames according to the 
marker frame rate

ODAU frames plays data back in frames according to the 
ODAU frame rate

fastest frames picks the data file (marker data file or voltage 
data file) with the highest frame rate and plays 
back all its frames
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Figure 11-5  Playback Properties

5. Select playback based on real time or frames. If frames is selected, 
the Show Time and Show Frames buttons are active. Select the 
desired option.

6. If desired, check Play data in a loop.

7. Select OK. The Playback Properties dialog closes and the playback 
bar updates to reflect the edits you have made. 

Note Apart from the Show Time and Show Frames options, all playback 
properties can be set directly on the playback bar or from the Playback 
option on the main menu bar. 

8. Data playback is controlled using the standard control buttons on the 
playback bar. The following keyboard shortcuts may also be used 
during playback:

• Up arrow — play data 

• Down arrow — pause data

• Left arrow — move back (in pause mode only)

• Right arrow — move forward (in pause mode only)

• Home — move to beginning of data

• End — move to end of data

Notes If you are playing a strip chart view, you can click anywhere along any 
data line to move the progress bar to that position. 
If you are playing spatial view, the spatial view toolbar is available and 
fully functional.  
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12 Calculations
As you are producing or reviewing data, First Principles provides you 
with the power to manipulate that data with calculations. Calculations are 
user-defined operations that use collection data to produce additional 
information in real time. The available calculations are as follows:

• Angle

• ASL EyeTracker

• Constants (3D and 6D and constant float)

• Distance

• Transform

• Inverse Transformation

• Relative

• Force Plate 6

• Force Plate 8

• Force Plate 8 Hall

• Centre of Pressure

12.1 About the Calculations Dialog
You can apply a calculation at any time during the experiment or during 
playback:
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1. From the main menu, select Collection/Playback > Calculations. 
The Calculations dialog appears:

Figure 12-1  Calculations Dialog

2. Click Add, and from the list that appears, select a calculation type. 
For more information about each type, see “Calculation Types” on 
page 114.

3. Click OK. A new calculation is created and added to the list in the 
Calculation dialog and activated in the current views, when the 
calculation dialog is closed. The background colour of each 
calculation in the list denotes its status as follows:

• Black — Currently selected calculation

• White — All inputs have been defined

• Yellow — Not all inputs have been defined

Note To rename the new calculation with a more relevant title, double-click it 
and type in a new name. Press Enter when you have finished, to save 
your changes. 
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4. Select the new calculation. The Calculation Dialog updates to 
provide you with appropriate fields for this calculation type:

• Calculation Parameters

• Calculation Input

An example of the Calculations Dialog with a Transform calculation 
selected is shown in “Calculation Dialog — Transform Example” on 
page 113. 

Figure 12-2  Calculation Dialog — Transform Example

5. Use the descriptions provided in “Calculation Types” on page 114 to 
modify the Calculation Parameters available for your chosen 
calculation type. 

6. Click Apply to update the desired Calculation Input fields so that 
they reflect the chosen Calculation Parameters. 

7. Enter the desired Calculation Input. 

8. Click Close to close the Calculations dialog and add the calculation 
to the experiment. 
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12.2 Calculation Types

Angle
Angle calculates the angle between two vectors. These vectors are 
defined using 3D points in the measurement volume (for example, 
markers). For example, a biomedical researcher might apply the Angle 
calculation to the experiment data to calculate the angle of rotation of a 
specific joint on a person’s body. 

Angle calculations include the following calculation parameters: 

Angle calculations requires that you create two vectors using the 
following calculation input:

Table 12-1  Angle Calculation Parameters

Parameter Description
Units Angle can be represented as either degrees or 

radians.

Angle Type Angle Type dictates the way the angle is calculated:
•   Angle between 2, 3D vectors
•   Angle between 2, 2D vectors, created by 

projecting 3D vectors onto a selected plane.

Table 12-2  Angle Calculation Input

Input Description
Head Head is a 3D point in the measurement volume that 

represents the head of a vector.

Tail Tail is the 3D point in the measurement volume that 
represents the tail of a vector.
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ASLEyeTracker
ASLEyeTracker calculations include the following calculation 
parameters: 

ASLEyeTracker calculations require the following calculation input:

Table 12-3  ASLEyeTracker Calculation Parameters

Parameter Description
COM port COM port defines which COM port on the host 

computer the eye tracker is plugged into. (Default 1)

Baud Rate Baud Rate is the communication rate between the eye 
tracker and the host computer. (Default 19200)

Stop Bits Stop Bits are bits set for each byte of data 
transmitted. (Default 1)

Data Bits Data Bits dictate the number of bits that create a byte. 
(Default 8)

Parity Parity enables parity checking: the use of parity bits 
to check that data has been transmitted accurately. 
The parity bit is added to every data unit (typically 
seven or eight bits) that are transmitted. The parity bit 
for each unit is set so that all bytes have either an odd 
number or an even number of set bits. (Default No)

HW 
Handshaking 

Hardware flow control. If No is selected, software 
flow control is used (Default No)

Table 12-4  ASLEyeTracker Calculation Input

Input Description
Transform01 Transform01 is the transformation produced by a 

tool/rigid body attached to the subject’s head. This 
transformation is transmitted to the ASLEyeTracker 
using the communication parameters set listed in 
Table 12-3. ASLEyeTracker will then use this data, in 
combination with the movement of the subject’s eye, 
to calculate the location of the subject’s gaze. 
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Constants
Constant is a value placeholder that you can apply in other calculations. It 
does not perform a calculation. First Principles provides three different 
formats for constants:

Constant3D  Constant3D value consists of an x, y and z value. This can 
included in any calculation that manipulates 3D data. 

Constant6D  Constant 6D value consists of an x, y, z, Rx, Ry, and Rz 
value. This can be included in any calculation that manipulates 6D data.

ConstantFloat  ConstantFloat value is an integer that can be included in 
any calculation that manipulates scalar values.

Distance
Distance calculates the distance (in mm) between two points in the 
measurement volume.

Distance calculations include the following calculation parameters:

The calculation input required reflects the Input Type you selected. If you 
change the Input Type, click Apply to update the calculation inputs

Transform
Transform applies a transformation to an existing value. For example, 
Transform could be used to apply one rigid body’s transformation to 
another rigid body in the experiment. 

Table 12-5  Distance Calculation Parameters

Parameter Description
Input Type Input Type dictates the kind of points you will be 

selecting. The software can calculate the distance 
between any combination of 3D and 6D points.
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Transform calculations include the following calculation parameters:

The calculation input required reflects the number of 3D and 6D inputs 
you selected. These represent the number of 3D (markers) or 6D (rigid 
bodies) to which you wish to apply the transformation. If you change the 
number of 3D or 6D inputs, click Apply to update the calculation inputs. 

Inverse Transformation
Inverse transformation calculates the inverse of the selected 
transformation input. 

Inverse transformation calculations require the following calculation 
input: 

Table 12-6  Transform Calculation Parameters

Parameter Description
Number of 6D Inputs An integer between 0-7
Number of 3D Inputs An integer between 0-7

Table 12-7  Transform Calculation Input

Input Description
Transformation From the Transformation drop-down list, select the 

transform you want to apply to the remaining 
calculation inputs. The remaining calculation inputs 
reflect the number of 3D and 6D inputs you select. 
Select each input from the corresponding drop-down 
list. 

Table 12-8  Inverse Transform Calculation Input

Input Description
Transformation From the Transformation drop-down list, select the 

transformation for which you want to calculate the 
inverse.
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Relative
Relative calculation calculates a new position or transformation in a 
coordinate system of another reference transformation. It can also 
calculate a new position relative to reference position.

Relative calculations include the following calculation parameters:

Relative calculations require the following calculation inputs:   

Table 12-9  Relative Calculation Parameters

Parameter Description
Input Type Input Type dictates the kind of points you 

will be selecting. The software can calculate 
a relative position or transformation between 
any combination of 3D and 6D points. Click 
Apply whenever you change this setting to 
appropriately update the calculation inputs.

Table 12-10  Relative Calculation Input Type 6D-6D)

Input Description
Reference 
Transformation

From the Ref Transform drop-down list, select the 
transformation to be used as reference.

 
Transformation

From the Transform drop-down list, select the 
transformation to be calculated, relative to the 
reference.

Table 12-11  Relative Calculation Input Type 6D-3D

Input Description
Reference 
Transformation

From the Ref Transform drop-down list, select the 
required transformation to be used as reference.

Position From the Position drop-down list, select the position 
to be calculated, relative to the reference.
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Force Plate 6 
Force plate 6 calculation re-interprets the force plate output analog 
signals to force and moment vectors. This calculation is meant for use on 
force plates with six analog output channels (for example, Bertec, 
AMTI). The outputs of this calculation consist of force and moment 
vectors in the force plate local coordinate system and the force plate 
transformation in the global coordinate system. 

Input: six voltage values representing Fx, Fy, Fz, Mx, My, Mz outputs 
from the force plate.

Output: (Fx, Fy, Fz, Mx’, My’, Mz, Transformation); [N, Nm, mm]

Force and Moment Vector Part of the Output

Force and moment vector values are calculated from analog inputs using 
the following formula:

FM = Cal * A / (1000000* Vexc * G)

where:

FM is the resulting 6 element force and moment vector, (Fx, Fy, Fz, Mx, 
My, Mz)

Cal is the 6x6 calibration matrix provided by the plate manufacturer. Top 
half of the matrix is assumed to be in  [VN/µV] and the bottom half in 
[VNm/µV] units,

A is the input 6 element analog signal vector measured and provided by 
the force plate (Fxv, Fyv, Fzv, Mxv, Myv, Mzv) [V]

V exc is the amplifier excitation voltage

G is the amplifier gain setting

Table 12-12  Relative Calculation Input Type 3D-3D

Input Description
Reference 
Position

From the Ref Position drop-down list, select the 
required position to be used as reference.

Position From the Position drop-down list, select the position 
to be calculated, relative to the reference.
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The resultant moment vector represents moment above the surface of the 
force plate and is calculated as follows:

Mx' = Mx - Fy * Zoffset

My' = My + Fx * Zoffset

where Zoffset is the user supplied vertical offset from the top plane to the 
origin of the force platform. (It is the z coordinate of the user supplied 
Centre Offset (mm) calculation parameter.) The calculation 
automatically adjusts the Centre Offset such that the z value is always 
positive, as assumed by all equations.

The resulting force and moment output vector is then (Fx, Fy, Fz, Mx’, 
My’, Mz) [N, Nm].

Transformation Part of the Output

Transformation output provides the information of where the force plate 
is in the Optotrak measurement volume

The transformation value is important only in the following two 
circumstances:

• The SpatialView (see page 90) is required to show the real 
orientation of the force plate in the measurement volume 

or

• The multiple force plates are inputs into another calculation 
where their relative position information is important (for 
example Centre of pressure calculation). 

Note The information below is only applicable if you need this calculation to 
provide the correct transformation value.

The transformation value provided by this calculation is based on three 
force plate corner coordinates, measured on the plate surface and 
corrected by the Centre Offset value supplied by the manufacturers. 

Set the correct transformation output of the force plate as follows:
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1. Enter the manufacturer supplied Centre Offset (in mm) in the force 
plate coordinate system. 

2. Enter 3D coordinates of corners 1, 2 and 3 on the top plane of the 
plate (refer to Figure 12-3) in that order, measured in the Optotrak 
coordinate system. The corners can be measured by using the 
digitizing probe and ProbeView (see page 100). The corners 
description in the force plate coordinate space are: 
1:(X+,Y+); 2:(X-,Y+); 3:(X-, Y-).

Figure 12-3  Force Plate Coordinate Space

Centre Offset value is supplied by the manufacturer, and is the result of 
the calibration procedure. It represents the offset of the force plate 
coordinate space from the physical centre of its sensors.  

Note The Centre Offset value is sometimes reported from the real centre to the 
top of the plate, and not from the top to the centre, as assumed by the 
application. First Principles automatically recognizes the right orientation 
of the offset vector, based on the value of the Z coordinate of the offset.

Force Plate 8
Force plate 8 calculation re-interprets force plate output analog signals to 
force and moment vectors. This calculation is meant for use on piezo-
electric force plates with eight analog output channels (for example 
Kistler). The outputs of this calculation are force and moment vectors in 
the force plate local coordinate system and the force plate transformation 
in the global coordinate system. 

Corners to be digitized
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Input: Eight analog values Vx12, Vx34, Vy14, Vy23, Vz1, Vz2, Vz3, 
Vz4 representing Fx12, Fx34, Fy14, Fy23, Fz1, Fz2, Fz3, Fz4  outputs 
from the force plate.

Output: (Fx, Fy, Fz, Mx', My', Mz, Transformation); [N, Nm, mm].

Force and Moment Vector Part of the Output 

Force and moment vector values are calculated from analog inputs using 
the following formulae:

Fx12 = Vx12 / Sx * XYRange / 5

Fx34 = Vx34 / Sx * XYRange / 5

Fy14 = Vy14 / Sy * XYRange / 5

Fy23 = Vy23 / Sy * XYRange / 5

Fz1  =  Vz1 / Sz * ZRange  / 5

Fz2  =  Vz2 / Sz * ZRange  / 5

Fz3  =  Vz3 / Sz * ZRange  / 5

Fz4  =  Vz4 / Sz * ZRange  / 5

where Vx, Vy, Vz [V] are voltage outputs from the force plate, Sx, Sy, Sz 
[pC/N]  are sensitivity values for respective channels and XYRange, 
ZRange [pC/5V] are the force plate output ranges for particular channels.

Measured forces at sensors are then used to produce the overall force and 
moment vectors as follows:

Fx = Fx12 + Fx34

Fy = Fy14 + Fy23

Fz = Fz1 + Fz2 + Fz3 + Fz4

Mx = b * (Fz1 + Fz2 - Fz3 - Fx4)

My = a * (-Fz1 + Fz2 + Fz3 - Fz4)

Mz = b * (-Fx12 + Fx34) + a * (Fy14 - Fy23)

where a is the half of the sensor’s X distance [m] and b is the half of the 
sensor’s Y distance [m], in the plate coordinate system.
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The moment vector represents moment above the surface of the force 
plate and is calculated as follows:

Mx' = Mx - Fy * Zoffset

My' = My + Fx * Zoffset

where Zoffset is the user supplied vertical offset from the top plane to the 
origin of the force platform. (It is the z coordinate of the user supplied 
Centre Offset (mm) calculation parameter.) The calculation 
automatically adjusts the Centre Offset such that the z value is always 
positive, as assumed by all equations.

The resulting force and moment output vector is then:

(Fx, Fy, Fz, Mx’, My’, Mz) [N, Nm].

Transformation Part of the Output

Transformation output provides the information of where the force plate 
is in the Optotrak measurement volume

The transformation value is important only in the following two 
circumstances:

• The SpatialView (see page 90) is required to show the real 
orientation of the force plate in the measurement volume 

or

• The multiple force plates are inputs into another calculation 
where their relative position information is important (for 
example Centre of pressure calculation). 

Note The information below is only applicable if you need this calculation to 
provide the correct transformation value.

The transformation value provided by this calculation is based on three 
force plate corner coordinates, measured on the plate surface and 
corrected by the Centre Offset value supplied by the manufacturers. 

Set the correct transformation output of the force plate as follows:
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1. Enter the manufacturer supplied Centre Offset (in mm) in the force 
plate coordinate system. 

2. Enter 3D coordinates of corners 1, 2 and 3 on the top plane of the 
plate (refer to Figure 12-3) in that order, measured in the Optotrak 
coordinate system. The corners can be measured by using the 
digitizing probe and ProbeView (see page 100). The corners 
description in the force plate coordinate space are: 
1:(X+,Y+); 2:(X-,Y+); 3:(X-, Y-).

Centre Offset value is supplied by the manufacturer, and is the result of 
the calibration procedure. It represents the offset of the force plate 
coordinate space from the physical centre of its sensors.  

Note The Centre Offset value is sometimes reported from the real centre to the 
top of the plate, and not from the top to the centre, as assumed by the 
application. First Principles automatically recognizes the right orientation 
of the offset vector, based on the value of the Z coordinate of the offset.

Force Plate 8 Hall
Force plate 8 Hall calculation re-interprets the force plate output analog 
signals to force and moment vectors. This calculation is meant for AMTI 
Hall-effect force plate, using the 8-channel analog output. It is applicable 
to AMTI's AccuSwayPlus, AccuGait, HE6x6, and other AMTI Hall-
effect based force plates with analog voltage outputs.

The outputs of this calculation consist of force and moment vectors in the 
force plate local coordinate system and the force plate transformation in 
the global coordinate system. 

Input: eight voltage values representing FzC, FzD, FzA, FzB, FyAC, 
FxDC, FxAB, FyBD outputs from the force plate. 

Output: (Fx, Fy, Fz, Mx', My', Mz, Transformation); [N, Nm, mm] 

Force and Moment Vector Part of the Output 

Measured force and moment vector values are calculated from analog 
inputs using the following formula: 

FM = Cal * A 
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where: 

FM is the resulting 6 element force and moment vector, (Fx, Fy, Fz, Mx, 
My, Mz) 

Cal is the 6x8 calibration matrix provided by the plate manufacturer. Top 
half of the matrix is assumed to be in [N/V] and the bottom half in [Nm/
V] units, 

A is the input 8 element analog signal vector measured and provided by 
the force plate (FzC, FzD, FzA, FzB, FyAC, FxDC, FxAB, FyBD) [V] 

The resultant moment vector represents moment above the surface of the 
force plate and is calculated as follows: 

Mx' = Mx - Fy * Zoffset 

My' = My + Fx * Zoffset 

where Zoffset is the user supplied vertical offset from the top plane to the 
origin of the force platform. (It is the z coordinate of the user supplied 
Centre Offset (mm) calculation parameter.) The calculation 
automatically adjusts the Centre Offset such that the z value is always 
positive, as assumed by all equations. 

The resulting force and moment output vector is then (Fx, Fy, Fz, Mx', 
My', Mz) [N, Nm]. 

Transformation Part of the Output

Transformation output provides the information of where the force plate 
is in the Optotrak measurement volume

The transformation value is important only in the following two 
circumstances:

• The SpatialView (see page 90) is required to show the real 
orientation of the force plate in the measurement volume 

or

• The multiple force plates are inputs into another calculation 
where their relative position information is important (for 
example Centre of pressure calculation). 
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Note The information below is only applicable if you need this calculation to 
provide the correct transformation value.

The transformation value provided by this calculation is based on three 
force plate corner coordinates, measured on the plate surface and 
corrected by the Centre Offset value supplied by the manufacturers. 

Set the correct transformation output of the force plate as follows:

1. Enter the manufacturer supplied Centre Offset (in mm) in the force 
plate coordinate system. 

2. Enter 3D coordinates of corners 1, 2 and 3 on the top plane of the 
plate (refer to Figure 12-3) in that order, measured in the Optotrak 
coordinate system. The corners can be measured by using the 
digitizing probe and ProbeView (see page 100). The corners 
description in the force plate coordinate space are: 
1:(X+,Y+); 2:(X-,Y+); 3:(X-, Y-).

Centre Offset value is supplied by the manufacturer, and is the result of 
the calibration procedure. It represents the offset of the force plate 
coordinate space from the physical centre of its sensors.  

Note The Centre Offset value is sometimes reported from the real centre to the 
top of the plate, and not from the top to the centre, as assumed by the 
application. First Principles automatically recognizes the right orientation 
of the offset vector, based on the value of the Z coordinate of the offset.

Centre of Pressure
Centre of pressure calculation calculates the position of the centre of 
pressure from the outputs of force plate calculations. It can take up to 
eight force plates as the input and calculate the total centre of pressure in 
the global coordinate system using transformations of each force plate 
and their force and moment outputs.
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Centre of pressure calculations include the following calculation 
parameters:

Input: force plate data

Output: 3D point in the Optotrak coordinate system

The centre of pressure of one force plate in the force plate local 
coordinate system is calculated as

COPx = -My' / Fz

COPy = Mx' / Fz

COPz = 0,

where My' is the y coordinate of the moment above the surface of the 
force plate, Mx' is the x coordinate of the moment above the surface of 
the force plate (see force plate 6 or force plate 8 calculations for 
information on how Mx', My' are calculated).

Centre of pressure in the Optotrak coordinate system, calculated from 
multiple force plate data, is calculated as a weighted average of centres of 
pressure of participating force plates:

COPx = (Σ (COPxi
g * |Fzi|) )  /  Σ|Fzi|

COPy = (Σ (COPyi
g * |Fzi|) )  /  Σ|Fzi|

Table 12-13  Relative Calculation Parameters

Parameter Description
Number of plates An integer of 1 to 8. Click Apply whenever 

you change this setting to appropriately 
update the calculation inputs.

Fz Threshold [N] Sets the Fz threshold that the force plate has 
to exceed, in order to be included in the 
calculation. This avoids extraneous noise, 
for example from an unloaded force plate, 
being included in calculations. (If the force 
plate does not exceed the Fz threshold, it 
will be reported as missing.) 
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COPz = (Σ (COPzi
g * |Fzi|) )  /  Σ|Fzi|

where Fzi is the z coordinate of the force vector in the force plate 
coordinate system,  COPi

g is the 3D location  of the centre of pressure of 
the force plate 'i' in the Optotrak coordinate system calculated as

COPi
g = T(COPi),

where COPi is the 3D location of the centre of pressure of the force plate 
in the force plate local coordinate system, T is the transformation from 
force plate coordinate system to the Optotrak coordinate system.
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13 Exporting Data
First Principles provides the functionality for you to export data in a 
variety of file formats. The file export interface allows you to:

• quickly select source files and destination folders

• select applicable export file formats

• define export subsets by time or frame

First Principles can export data in two ways: via the export dialog, or 
using the auto export feature. For further information, refer to “Exporting 
Data” on page 130

13.1 First Principles File Formats
First Principles produces the following file formats:

• collection file (.nco)

• experiment file (.exp)

• tool definition file (rig)

• raw data file (.nrw, .nor) (Optotrak and ODAU II raw data files)

First Principles can open and play the following file formats:

• collection file (.nco)

• 3D data file (.n3d)

• 6D data file (.n6d)

• raw data file (.nrw, .nor) (Optotrak and ODAU II raw data files)

13.2 Exported Data File Formats
First Principles can convert data and export it in the following file 
formats:

• 3D data file (.n3d) in NDI floating point format

• 6D data file (.n6d) in NDI floating point format

• ODAU II data file (.nov) ODAU II voltage in NDI floating point 
format
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• c3d (.c3d)

• ASCII data files (.txt)

• Comma Separated Value files (.csv)

• tab separated value files (.xls)

13.3 Exporting Data
First principles can export data in two ways; using an auto export feature 
that exports data as soon as recording has finished and manually using the 
export dialog. Both methods are described below. 

Auto Export
To automatically export data from First Principles, follow the procedure 
detailed below:

1. From the main menu, select Settings > Auto Export. The following 
dialog appears:

Figure 13-1  Auto Export Dialog

2. Check the file types you want to export and select the delimiter from 
the drop-down options. If you select either the NDI 6D, or All to 
ASCII option, select a Rotation Format from the drop-down 
options.

Notes NDI 6D files always contain Euler data in radians, even if Euler (deg) is 
selected.
To export a collection file to C3D, the ODAU frame frequency must be an 
integer multiple of the marker frame frequency.
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3. Select OK. The dialog closes. When you next stop a recording 
session, the data will be exported to the same directory defined 
during session setup and in the formats defined above.  

Manual Export
To manually export data from First Principles, using the export dialog, 
follow the procedure detailed below:

1. From the main menu, select File > Export Data. The following 
dialog appears:

Figure 13-2  Export Data Dialog

2. Click Add File(s) and browse to and select the files that you want to 
export. The file(s) location appears in the Source File column. (If 
you want to remove files from the list, select the file and click 
Remove File(s), or press the Delete key.)
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3. In the Export Properties > Destination Folder section, click 
Browse and browse to the location where you want to store the 
exported data. The destination folder appears in the Destination 
Folder column.

4. In the Export To section, check the desired file formats that will be 
applied to the exported data. Read the notes below.

Notes The Export To section is context-sensitive and the options for export file 
formats will only be enabled if that file format is applicable to the selected 
file.

The Delimiter drop-down options (TAB and Comma) is only enabled if 
ASCII is checked. Select TAB to export the file as Microsoft Excel (.xls) 
and Comma to export the file as .csv, or specify your own delimiter in the 
drop-down list and export the data as a .txt file. 

5. In the Export Subset section, type in the Start and End  limits for 
the exported data. You can input limits in either Time or Frames and 
both columns will update. The Max fields display the maximum 
possible data length applicable to the selected file.

6. If you are exporting 6D data, select the desired Rotation Format 
from the drop-down options.

7. When you have completed your selections, click Export. The data is 
exported to the selected destination folder. 
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14 Quick Reference: First Principles Main Menu

Table 14-1  Main Menu Items

Menu Item Sub-menu Item Description
File New 

Experiment
Create a new experiment.

Open 
Experiment

Open a previously saved experiment to 
continue work.

Edit 
Experiment

Change the setup for the current 
experiment.

Save 
Experiment

Save the current experiment.

Save 
Experiment As

Save the current experiment under a 
different name/directory.

Close 
Experiment

Close the current experiment and 
disconnect the software from the 
system.

Open 
Collection

Open a collection for playback, and/or 
manipulation.

Save Collection Save the settings of currently used 
views of the collection.

Close 
Collection

Close the current collection.

Export Data Export the selected data files into 
different formats/directories for future 
analysis.
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Collection
(active 
when 
running 
experimen
t view is 
selected)

Record Start a new collection.

Stop Stop the current collection or cancel 
External Trigger mode.

Markers Active Turn on/off all connected markers.

External 
Trigger

Turn on an external trigger mode used 
to start new collections.

Collection 
Properties

Change collection settings, such as 
length, delay, and units.

Calculations Add calculations to the current 
experiment/collection.

Playback
(active 
when 
collection 
file view is 
selected)

Play Play back the current collection.

Pause Pause a playback.

Stop Stop a playback and return the cursor 
to the start position.

Playback 
Properties

Change playback settings, such as 
loop, speed, and units.

Calculations Add calculations to the current 
experiment/collection.

Table 14-1  Main Menu Items (Continued)

Menu Item Sub-menu Item Description
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View Toolbar Show/hide the main toolbar at the top 
of the main window.

Control bar Show/hide the recording/playback 
control bar at the bottom of the main 
window.

Session 
Summary

Show/hide the session summary. 
(Active only after the first recording.)

3D Data Show/hide 3D data in the selected 
view.

6D Data Show/hide 6D data in the selected 
view.

ODAU Voltage 
Data

Show/hide ODAU II voltage data in 
the selected view.

Calculations Show/hide applied calculations in the 
selected view.

View Properties Change settings for the selected view.

Text View Open a new Text View window.

Missing Data 
View

Open a new Missing Data View 
window.

Probe View Open a new Probe View window.

Raw Data View Open a new Raw Data View window.

Spatial View Open a new Spatial View window.

Strip Chart 
View

Open a new Strip Chart View window.

Video View Open a new Video View window.

Table 14-1  Main Menu Items (Continued)

Menu Item Sub-menu Item Description
First Principles User Guide - Revision 3 135



Settings Marker 
Settings/
Frequency

Set the markers frequency, duty cycle 
and power

Communication 
Settings

Change the communication settings 
used to connect the host computer to 
the Optotrak System.

Coordinate 
System Details

Open and review the Environment 
Setup for the current experiment.

Default Exports Create default exporting settings that 
will be performed automatically with 
each collection.

Utilities Query System Re-initialize the communication 
between the host computer and the 
Optotrak System, to determine the 
hardware setup.

Show Error Log Show the last system error logged. 

Show Latest 
Wireless 
Configuration

Show the latest wireless mode Smart 
Marker configuration tree.

Pivot Tool/
Rigid Body

Open the Pivot wizard to calculate a 
tool/rigid body’s tip offset.

Window Cascade Arrange the open windows in a 
cascade fashion.

Tile Arrange the open windows in a tile 
fashion.

Help Help Topics Open First Principles Online Help. 

Licencing Info Shows the licence state of the 
application modules and allows you to 
licence them if necessary

About First 
Principles

Open the software description window. 

Table 14-1  Main Menu Items (Continued)

Menu Item Sub-menu Item Description
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15 Abbreviations and Acronyms

Table 15-1  Abbreviations and Acronyms

Abbreviation or 
Acronym Meaning

DHCP Dynamic Host Configuration Protocol 

IP Internet Protocol

ODAU Optotrak Data Acquisition Unit

RMS Root Mean Square

SCSI Small Computer System Interface

SCU System Control Unit

SROM Serial Read Only Memory



Glossary
Glossary

.csv File

A .csv file is a Comma Separated Value file that stores characterization 
data in ASCII format.

.rig File

A .rig file is a rigid body’s tool definition file.

.rom File

A .rom file is a tool’s tool definition file.

3D Data

3D data refers to the x, y, and z positions of a marker.

3D RMS Error

3D RMS (Root Mean Square) Error is determined by calculating the 
difference between the measured locations of markers on a tool and the 
marker positions in the tool definition file.

Alignment

Alignment is the process of adjusting a tool or Position Sensor's local 
coordinate system.

Centroid

A centroid is the centre point of an imagined three-dimensional volume 
created by the selected markers.

Collection

A collection is a set of data that is saved to a session. 
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Glossary
Euler Rotation

An Euler rotation is a mathematical method of describing a rotation in 
three dimensions: the rotation of the object around each axis (Rx, Ry, and 
Rz), applied in a specific order.

Euler Transformation

An Euler transformation is a mathematical method of describing 
translations and rotations in three dimensions. Six values are reported for 
an Euler transformation: the three translational values in the x, y, and z-
axes; and rotations around each of the axes, Rx, Ry, and Rz.

Experiment

An experiment is a specific Optotrak System setup that uses markers, 
rigid bodies, tools, and/or ODAU II units to measure the movement and/
or location of a subject.

Frame Frequency

The frame frequency is the number of frames of data per second 
measured by the Optotrak System.

Frame

A frame contains the measured positions of the markers in the detection 
region at a particular point in time.

Global Coordinate System

The global coordinate system is the Optotrak System's coordinate system. 
The global coordinate system is used by the measurement system as a 
frame of reference against which tool transformations are reported. By 
default, the global coordinate system's origin is set at the Position Sensor. 

Imaginary Marker

An imaginary marker is used to identify a point where it is difficult or 
undesirable to affix an actual marker.
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Glossary
Local Coordinate System

A local coordinate system is a coordinate system assigned to a specific 
tool or rigid body. 

Marker

A marker is an object that can be detected and tracked with an Optotrak 
System. 

Marker Frequency

Marker frequency is the rate (Hz) at which markers are activated within a 
frame.

Marker Period

Marker period is the inverse of the marker frequency. 

Marker Power

Marker power refers to the overall "brightness" of the markers. Marker 
power affects the strength of the signals received by the Position Sensor, 
and is dependant on the marker frequency, duty cycle and voltage applied 
to the marker.

Marker Voltage

Marker voltage is one of the factors that determine marker power. The 
voltage can range from 5 - 12 V.

Pivoting

Pivoting is a procedure (of rotating a tool about its tip) used to determine 
the tool tip offset.

Position Sensor

The Position Sensor is the component of the Optotrak Certus System that 
collects marker position data and sends the raw data to the System 
Control Unit.
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Glossary
Reference Tool

A reference tool is a tool or rigid body whose local coordinate system is 
used as a frame of reference in which other tools are reported/measured.

Registration

Registration is a process that aligns the coordinate systems of multiple 
Position Sensors to a common coordinate system.

Rigid Body

A rigid body is an object on which three or more markers are fixed 
relative to one another.

Rigid Body Definition

A rigid body definition is a description of the number and locations of 
markers on a rigid body. 

Session

A session is an instance of an experiment.

Tool

A tool is a rigid body that incorporates its tool definition file in an SROM 
device. 

Tool Definition File

A tool definition file stores information about a tool or rigid body. This 
includes information such as the placement of the tool's markers, the 
location of its origin, and its manufacturing data. A tool definition file 
can be formatted in two ways: .rig for rigid bodies, or .rom for tools.

Tool Origin

The tool origin is the origin of the tool's local coordinate system.
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Glossary
Tool Tip Offset

The tool tip offset is the vector between the tip of the tool and the tool 
origin.

Transformation

A transformation is a combination of translation and rotation values that 
describe a change of the tool or rigid body's position and orientation.

User-defined Coordinate System

A user-defined coordinate system is a global coordinate system in which 
the user has changed the location of the default origin and/or the 
orientation of its axes.
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record  1

derivative calculations  111,  116
digitize points  100
digitized points  31,  35
digitizing imaginary markers  70
distance calculations  111
duty cycle  45,  61

E
environment setup  3,  17
environment setup wizard  18
Ethernet connection  15
experiment  1

data viewing  82
process  2
setup  3

exporting data  129

F
force plate 6 calculation  119
force plate 8 calculation  121
frame frequency  50,  65
frame of reference  44,  58
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G
global coordinate system  3,  31

I
imaginary markers  48,  62

digitizing  70
installing First Principles  5
inverse calculation  117

L
licences  6

M
manipulate data  1
manipulating views  94
marker

advanced settings  45
firing sequences  59
frequency  45,  60
power  45,  60
rigid body  59
setup  42,  55
tool  59
view  92
voltage  46,  61

missing data view  82,  84
multiplexer  51,  66

N
new registration  23

O
ODAU II  139
ODAU II setup  49,  64
Optotrak 3020  41
Optotrak Certus  53

P
PCI card  14
pivot procedure  74
playback data  1
probe view  82,  100

R
raw data view  82,  87
record data  1
Register  28
registration  3,  17,  24
relative calculation  118
rigid body  48,  61

setup  46
RMS error  28

S
scan frequency  51,  66
SCSI card  14
session setup  3,  68
settings communication  13
setup

environment  3,  17
experiment  3
marker  42
ODAU II  49,  64
Optotrak 3020  41
Optotrak Certus  53
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rigid body  46,  61
session  3,  68

software
installation  5
licences  6

spatial view  82,  90
SROM device  26,  35
strip chart view  82,  97
system requirements  5

T
text view  82,  83
tool definition file  26,  30,  35
transform calculations  111,  116

V
video view  82,  102
viewer panes

shortcuts  94
viewing experiment data  82
views

manipulation  94
missing data  82,  84
probe  82,  100
raw data  82,  87
spatial  82,  90
strip chart  82,  97
text  82,  83
video  102
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